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About this user’s guide
This user’s guide provides information about basic understanding of the 
machine as well as detailed explanation on each step during the actual 
usage. Both novice users and professional users can refer to this guide for 
installing and using the machine.
This explanation is mainly based on the Microsoft Windows operating 
system.
Some terms in this guide are used interchangeably, as below.

• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• The model name such as CLP-6xx Series is synonymous with the 

machine.

The following table offers the conventions of this guide.

Convention Description Example

Bold Used for texts on the 
display or actual prints on 
the machine.

Start

Note Used to provide 
additional information or 
detailed specification of 
the machine function and 
feature.

Note 
The date format 
may differ from 
country to country.

Caution Used to give users 
information to protect the 
machine from possible 
mechanical damage or 
malfunction.

Caution
Do not touch the 
green underside of 
the toner cartridge.

Footnote Used to provide more 
detailed information on 
certain words or a 
phrase. 

a. pages per minute

(See page 
1.1 for 
more 
information)

Used to guide users to 
the reference page for 
the additional detailed 
information.

(See page 1.1 for more 
information)

Finding more information
You can find information for setting up and using your machine from the 
following resources, either as a print-out or onscreen.

Quick Install 
Guide

Provides information on setting up your 
machine and this requires that you follow 
the instructions in the guide to prepare the 
machine.

Online User’s 
Guide

Provides you with step-by-step 
instructions for using your machine’s full 
features, and contains information for 
maintaining your machine, 
troubleshooting, and installing 
accessories. 
This user’s guide also contains a Software 
section to provide you with information on 
how to print documents with your machine 
in various operating systems, and how to 
use the included software utilities.

Note 
You can access the user’s guide in other 
languages from the Manual folder on the 
printer software CD.

Printer Driver 
Help

Provides you with help information on 
printer driver properties and instructions 
for setting up the properties for printing. To 
access a printer driver help screen, click 
Help from the printer properties dialog 
box.

Samsung website If you have Internet access, you can get 
help, support, printer drivers, manuals, 
and order information from the Samsung 
website, www.samsungprinter.com.

http://www.samsungprinter.com
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Safety and Regulatory Information

Important Precautions and Safety Information
When using this machine, these basic safety precautions should always be 
followed to reduce risk of fire, electric shock, and injury to people:
1 Read and understand all instructions.

2 Use common sense whenever operating electrical appliances.

3 Follow all warnings and instructions marked on the machine and in the 
literature accompanying the machine.

4 If an operating instruction appears to conflict with safety information, 
heed the safety information. You may have misunderstood the 
operating instruction. If you cannot resolve the conflict, contact your 
sales or service representative for assistance.

5 Unplug the machine from the AC wall socket before cleaning. Do not 
use liquid or aerosol cleaners. Use only a damp cloth for cleaning.

6 Do not place the machine on an unstable cart, stand or table. It may fall, 
causing serious damage.

7 Your machine should never be placed on, near or over a radiator, 
heater, air conditioner or ventilation duct.

8 Do not allow anything to rest on the power cable. Do not locate your 
machine where the cords will be abused by persons walking on them.

9 Do not overload wall outlets and extension cords. This can diminish 
performance, and may result in the risk of fire or electric shock.

10 Do not allow pets to chew on the AC power or PC interface cords.

11 Never push objects of any kind into the machine through case or 
cabinet openings. They may touch dangerous voltage points, creating a 
risk of fire or shock. Never spill liquid of any kind onto or into the 
machine.

12 To reduce the risk of electric shock, do not disassemble the machine. 
Take it to a qualified service technician when repair work is required. 
Opening or removing covers may expose you to dangerous voltages or 
other risks. Incorrect reassembly could cause electric shock when the 
unit is subsequently used. 

13 Unplug the machine from the PC and AC wall outlet, and refer servicing 
to qualified service personnel under the following conditions:
• When any part of the power cord, plug, or connecting cable is 

damaged or frayed.
• If liquid has been spilled into the machine. 
• If the machine has been exposed to rain or water.
• If the machine does not operate properly after instructions have been 

followed.
• If the machine has been dropped, or the cabinet appears damaged.
• If the machine exhibits a sudden and distinct change in performance.

14 Adjust only those controls covered by the operating instructions. 
Improper adjustment of other controls may result in damage, and may 
require extensive work by a qualified service technician to restore the 
machine to normal operation.

15 Avoid using this machine during a lightning storm. There may be a 
remote risk of electric shock from lightning. If possible, unplug the AC 
power for the duration of the lightning storm.

16 If you continuously print multiple pages, the surface of the output tray 
may become hot. Be careful not to touch the surface, and keep children 
away from the surface.

17 The Power cord supplied with your machine should be used for safe 
operation. If you are using a cord which is longer than 2 m with 110 V 
machine, then it should be 16 AWG1 or bigger.

18 SAVE THESE INSTRUCTIONS.

Environmental and Safety Consideration

Laser Safety Statement
The printer is certified in the U.S. to conform to the requirements of DHHS 21 
CFR, chapter 1 Subchapter J for Class I(1) laser products, and elsewhere, is 
certified as a Class I laser product conforming to the requirements of IEC 825.
Class I laser products are not considered to be hazardous. The laser system 
and printer are designed so there is never any human access to laser 
radiation above a Class I level during normal operation, user maintenance, or 
prescribed service condition.

Warning 
Never operate or service the printer with the protective cover removed from 
Laser/Scanner assembly. The reflected beam, although invisible, can 
damage your eyes.

1 AWG: American Wire Gauge
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When using this product, these basic safety precautions should always be 
followed to reduce risk of fire, electric shock, and injury to persons:

Ozone Safety
During normal operation, this machine produces ozone. 
The ozone produced does not present a hazard to the 
operator. However, it is advisable that the machine be 
operated in a well ventilated area.
If you need additional information about ozone, contact 
your nearest Samsung dealer.

Power Saver
This printer contains advanced energy conservation 
technology that reduces power consumption when it is 
not in active use.
When the printer does not receive data for an extended 
period of time, power consumption is automatically 
lowered. 

ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 
For more information on the ENERGY STAR program see http://
www.energystar.gov  

Recycling
Recycle or dispose of packaging materials for this product 
in an environmentally responsible manner.

Correct Disposal of This Product (Waste Electrical 
& Electronic Equipment)

(Applicable in the European Union and other European 
countries with separate collection systems)

This marking shown on the product or its literature, 
indicates that it should not be disposed with other 
household wastes at the end of its working life. To prevent 
possible harm to the environment or human health from 
uncontrolled waste disposal, separate this from other 
types of wastes and recycle it responsibly to promote the 
sustainable reuse of material resources. 

Household users should contact either the retailer where they purchased this 
product, or their local government office, for details of where and how they 
can take this item for environmentally safe recycling. 
Business users should contact their supplier and check the terms and 
conditions of the purchase contract. This product should not be mixed with 
other commercial wastes for disposal.

Radio Frequency Emissions

FCC Regulations
This device complies with Part 15 of the FCC Rules. Operation is subject to 
the following two conditions: 
• This device may not cause harmful interference, and 
• This device must accept any interference received, including interference 

that may cause undesired operation.

This device has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Caution: 
Changes or modifications not expressly approved by the manufacturer 
responsible for compliance could void the user’s authority to operate the 
equipment.

http://www.energystar.gov
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Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise 
emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry 
and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques 
applicables aux appareils numériques de Classe B prescrites dans la norme 
sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par 
l’Industrie et Sciences Canada.

Declaration of Conformity (European Countries)

Approvals and Certifications
The CE marking applied to this product symbolizes 
Samsung Electronics Co., Ltd. Declaration of Conformity 
with the following applicable 93/68/EEC Directives of the 
European Union as of the dates indicated:

January 1, 1995: Council Directive 73/23/EEC Approximation of the laws of 
the member states related to low voltage equipment.
January 1, 1996: Council Directive 89/336/EEC (92/31/EEC), approximation 
of the laws of the Member States related to electromagnetic compatibility.
March 9, 1999: Council Directive 1999/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual recognition of their 
conformity.
A full declaration, defining the relevant Directives and referenced standards 
can be obtained from your Samsung Electronics Co., Ltd. representative.

Replacing the Fitted Plug (for UK Only)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp 
plug and has a 13 amp fuse. When you change or examine the fuse, you 
must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. 
If you have lost the fuse cover, do not use the plug until you have another fuse 
cover. 
Please contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be 
suitable. However, some buildings (mainly old ones) do not have normal 13 
amp plug sockets. You need to buy a suitable plug adaptor. Do not remove 
the moulded plug.

Warning
If you cut off the moulded plug, get rid of it straight away.
You cannot rewire the plug and you may receive an electric shock if you 
plug it into a socket.
Important warning: You must earth this machine.
The wires in the mains lead have the following color code:
• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

If the wires in the mains lead do not match the colors marked in your plug, do 
the following:
You must connect the green and yellow wire to the pin marked by the letter 
“E” or by the safety ‘Earth symbol’ or colored green and yellow or green.
You must connect the blue wire to the pin which is marked with the letter “N” 
or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” 
or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

OpenSSL License
Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list 
of conditions and the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this 
list of conditions and the following disclaimer in the documentation and/or 
other materials provided with the distribution.
All advertising materials mentioning features or use of this software must 
display the following acknowledgment: "This product includes software 
developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://
www.openssl.org/)"
The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to 
endorse or promote products derived from this software without
prior written permission. For written permission, please contact openssl-
core@openssl.org.
Products derived from this software may not be called "OpenSSL" nor may 
"OpenSSL" appear in their names without prior written permission of the 
OpenSSL Project.
Redistributions of any form whatsoever must retain the following 
acknowledgment: "This product includes software developed by the 
OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' 
AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
This product includes cryptographic software written by Eric 
Young(eay@cryptsoft.com). This product includes software written by Tim 
Hudson (tjh@cryptsoft.com).
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Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights 
reserved.
This package is an SSL implementation written by Eric Young 
(eay@cryptsoft.com). The implementation was written so as to conform with 
Netscapes SSL.
This library is free for commercial and non-commercial use as long as the 
following conditions are aheared to. The following conditions apply to all code 
found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just 
the SSL code. The SSL documentation included with this distribution is 
covered by the same copyright terms except that the holder is Tim Hudson 
(tjh@cryptsoft.com). Copyright remains Eric Young's, and as such any 
Copyright notices in the code are not to be removed. If this package is used 
in a product, Eric Young should be given attribution as the author of the parts 
of the library used. This can be in the form of a textual message at program 
startup or in documentation (online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:
Redistributions of source code must retain the copyright notice, this list of 
conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this 
list of conditions and the following disclaimer in the documentation and/or 
other materials provided with the distribution.
All advertising materials mentioning features or use of this software must 
display the following acknowledgement: "This product includes cryptographic 
software written by Eric Young (eay@cryptsoft.com)" The word 
'cryptographic' can be left out if the rouines from the library being used are 
not cryptographic related:-). 
If you include any Windows specific code (or a derivative thereof) from the 
apps directory (application code) you must include an acknowledgement: 
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL 
THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or 
derivative of this code cannot be changed. i.e. this code cannot simply be 
copied and put under another distribution licence [including the GNU Public 
Licence.]



1.1   <Introduction>

1 Introduction
Thank you for purchasing this Samsung color printer. 

This chapter includes:
• Special features
• Machine overview
• Control panel overview
• Understanding the Status LED
• Understanding the menu map

Note
Some features are optional. Check the specifications 
sections. (See "Specifications" on page 10.1.)

Special features
Your new machine is equipped with special features.

Print with excellent quality and speed
• You can print in a full range of colors using cyan, 

magenta, yellow, and black.
• You can print up to 2400 x 600 dpi effective output. See 

Software section.
• Your machine prints A4-sized paper at up to 20 ppma  

(CLP-610 series), 24 ppm (CLP-660 series) and letter-
sized paper at up to 21 ppm (CLP-610 series), 25 ppm 
(CLP-660 series).

Handle different paper options with flexibility
• The multi-purpose tray supports letterhead, 

envelopes, labels, custom-sized media, postcards, and 
heavy paper. The multi-purpose tray holds up to 100 
sheets of plain paper for the CLP-610ND and CLP-660 
series.

• The 250-sheet tray 1 and 500-sheet optional tray  
support plain paper in various sizes. 

Create professional documents
• Print Watermarks. You can customize your documents 

with words, such as “Confidential”. See Software 
section.

• Print Posters. The text and pictures of each page of 
your document are magnified and printed across the 
sheet of paper and can then be taped together to form 
a poster. See Software section.

• You can use preprinted forms and letterhead with plain 
paper. See Software section.

Save time and money

Expand your machine’s capacity

* Zoran IPS Emulation compatible with PostScript 3 
© Copyright 1995-2005, Zoran Corporation. All rights 
reserved. Zoran, the Zoran logo, IPS/PS3, and 
OneImage are trademarks of Zoran Corporation.

* 136 PS3 fonts
Contains UFST and MicroType from Monotype Imaging Inc.

Print in various environments

• To save paper, you can print multiple pages on one 
single sheet of paper.

• This machine automatically conserves electricity by 
substantially reducing power consumption when not in 
use.

• To save paper, you can print on both sides of the paper 
(double-sided printing). This feature is supported 
depending on the models. See Software section.

• Your machine has an extra memory slot to expand their 
memory. (Page 8.1)

• Zoran IPS Emulation* compatible with PostScript 3 
Emulation* (PS) enables PS printing. 

• You can print with Windows 2000/XP/2003/Vista as 
well as Linux and Macintosh systems.

• Your machine is equipped with a USB interface and a 
network interface.

a. pages per minute
b. images per minute
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Machine overview
These are the main components of your machine.

Front view 

• The figure above shows your machine with the available accessories. (See page 8.1 for more information)
• The symbol * denotes an optional device.

Note 
• All illustrations on this user’s guide may differ from your machine depending on its options or models.
• The surface of the output tray may become hot if you print a large number of pages at once. Make sure that you do not touch the surface, and do 

not allow children near it.

1 output tray 7 multi-purpose tray
2 output support 8 tray 1
3 control panel 9 optional tray*

4 front cover 10 paper level indicator
5 front cover handle 11 multi-purpose tray paper width guides
6 multi-purpose tray handle
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Rear view 

• The figure above shows your machine with the available accessories.
• The symbol * denotes an optional device.

1 USB port 5 power switch
2 network port 6 power receptacle
3 15-pin Optional tray connection* 7 control board cover (Memory module, see page 9.1 for 

more information)

4 handle (Use these handles to move your machine.)
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Control panel overview

1 Display: Shows the current status and prompts during an 
operation.

5 Left/right arrow: Navigates available values by moving to the next 
or previous options.

2 Toner colors: The toner colors shown below the LCD display work 
together with the display messages. See Status LED with the toner 
cartridge messages on page 1.5.

6 OK: Confirms the selection on the display.

3 Status: Shows the status of your machine. (See "Understanding the 
Status LED" on page 1.5 for more information.)

7 Back: Sends you back to the upper menu level.

4 Menu: Enters Menu mode and scrolls through the available menus. 
(See "Understanding the Status LED" on page 1.5 for more 
information.)

8 Stop: Stops an operation at any time. 
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Understanding the Status LED
The color of the Status LED indicates the machine's current status.

Note 
Always check the message on the display to solve the problem. 
The instruction in the Troubleshooting section will guide you to 
operate the machine properly. See page 7.1 for more 
information.

Status Description

Off • The machine is powered off.

Green Blinking • When the green LED slowly blinks, the 
machine is receiving data from the computer.

• When the green LED blinks rapidly, the 
machine is printing data. 

On • The machine is powered on and can be used.
• The machine is in power save mode. When 

data is received, it switches to the ready mode 
automatically.

Red Blinking • A minor error has occurred and the machine 
is waiting for the error to be cleared. Check 
the display message, and solve the problem 
referring to "Understanding display 
messages" on page 7.7. 

• The toner cartridge is low. Order a new toner 
cartridge, see "Ordering supplies and 
accessories" on page 8.1. You can 
temporarily improve print quality by 
redistributing the toner. See "Replacing the 
toner cartridge" on page 6.4.

On • A problem has occurred such as a paper jam, 
opened cover or no paper in the tray, so that 
the machine can not continue the job. Check 
the message on the display, and refer to 
Understanding display messages on page 7.7 
to solve the problem.

• The toner cartridge is empty, exhausted, or 
needs to be changed. See "Understanding 
display messages" on page 7.7.

Status LED with the toner cartridge messages
The status of toner cartridges is indicated by the status LED and the LCD 
display. If the toner cartridge is low or needs to be changed, the status 
LED turns red and the display shows the message. However the arrow 
mark (or marks) shows which color toner is of concern or may be installed 
with a new cartridge. 

Example: 

The above example shows the magenta toner cartridge status indicated 
by the arrow. Check the message to find out what the problem is and how 
to solve it. See page 7.7 to browse the detailed information on error 
messages.
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Understanding the menu map
The control panel provides access to various menus to set up the 
machine or to use the machine's functions. Refer to the following 
diagram. 

Accessing menus
The next steps show how to print the menu map of this machine, and they 
are the general way to select menus and configure your machine.

1 Make sure your machine is properly connected with all the 
necessary cables, and turn on the machine.

2 Press Menu on the control panel, until you see the menu (ex. 
Information) you want on the bottom line of the display.

3 Press OK to access the menu.

4 Press left/right arrow until the menu item (ex. Menu Map) you want 
displays on the bottom line.

5 Press the OK button to confirm the selected item.

Note 
If the menu item has sub menus, repeat steps 4 and 5.

6 Press left/right arrow until the menu item (ex. Print?) you want 
displays on the bottom line.

7 Press OK to process your selection, save your input or selection.

An asterisk (*) appears next to the selection on the display, 
indicating that it is now the default.

8 To exit the menu, press Back repeatedly, or Stop.

Note 
• If no key is pressed within one minute, the machine 

automatically returns to ready mode.
• The print settings made from the printer driver on a connected 

computer override the settings on the control panel.

Menu overview

Information

Menu Map
Configuration
Demo Page
PCL Font List
PS Font List

Layout

Orientation
Simplex Margin
Duplex
Duplex Margin

System Setup

Language
Power Save
Auto Continue
Altitude Adj.
Auto CR
Job Timeout
Maintenance
Clear Setting

Emulation

Emulation Type
Setup

Network

TCP/IP
Ethernet Speed
Clear Setting
Network Info.

Color

Custom Color
Auto Color Reg.

Graphic

Resolution

Paper

Copies
Paper Size
Paper Type
Paper Source
Tray Chaining
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Description on each menu
The following tables provide the information on each menu.

Note 
The symbol * denotes an optional menu depending on 
machines.

Information 

Layout 

Menu Description

Menu Map You can print the menu map which shows the 
layout and current settings of this machine.

Configuration You can print the machine's current 
configuration. 

Demo Page The demo page is a sample of the machine’s 
imaging capabilities.

PCL Font List* You can print the PCL font list.

PS Font List* You can print the PS font list.

Menu Description

Orientation This menu allows you to select the direction in 
which information is printed on a page. 
Landscape and Portrait are selectable. 

Simplex Margin Set the margin of print materials for one-sided 
printing. You can increase or decrease the value 
in 1 mm (or inch) increments.
• Top Margin: Set the top margin.
• Left Margin: Set the left margin.

LandscapePortrait

Paper 

Duplex* To print on both sides of paper, choose the 
binding edge as follows.
• Long Edge: Flip on the long edge.
• Short Edge: Flip on the short edge.
Select Off to print on one side of the paper.

Duplex Margin* In this menu, you can set the margins for double-
sided printing. You can increase or decrease the 
value in 0.1 mm increments.
• Top Margin: Set the top margin.
• Left Margin: Set the left margin.
• Short Binding: Set the bottom margin of the 

back of the page for short binding.
• Long Binding: Set the right margin of the 

back of the page for long binding.

Menu Description

Copies You can select the maximum amount of copies.

Paper Size You can select the default paper size. (See page 
3.5 for more information)

Paper Type You can select the default paper type for the 
print media.

Menu Description

Long Edge in the 
Landscape orientation

Long Edge in the 
Portrait orientation

Short Edge in the 
Landscape orientation

Short Edge in the 
Portrait orientation
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Graphic 

System Setup 

Paper Source You can select the tray to process the print job. If 
you select Auto, your machine supplies the 
paper from the multi-purpose tray first, then the 
tray 1, and tray 2 for the last. So if any tray is 
empty, then the machine tries to search the 
paper from the next available tray. (See page 3.5 
for more information)

Tray Chaining When you select any other value except Auto 
from Paper Source and the selected tray is 
empty, you can set the machine to automatically 
print from other trays.
If this menu item is set to Off, the machine does 
not print until you insert paper into the specified 
tray.

Menu Description

Resolution You can select the default resolution. If the 
resolution is high, the clarity of the printouts is 
sharper, but the print time may take longer.
• Draft: If the printer language is PCL and your 

print jobs are text, select this option for the 
best speed and printing quality. This option is 
available only with PCL driver.

• Normal: If your print jobs are mostly text, 
select this option for the highest quality output.

• Best: select this option when your job contains 
bitmapped images, such as scanned photos or 
certain business graphics, that will benefit 
from enhanced line screening.

Menu Description

Language The language setting for the display on the 
control panel determines the language of the text 
that appears on the control panel display and for 
printing information. (See page 3.4 for more 
information)

Power Save When the machine does not receive data for an 
extended period of time, power consumption is 
automatically lowered. You can set how long the 
machine waits before going to power save. (See 
page 3.5 for more information)

Menu Description

Emulation 

Auto Continue This item determines whether or not the machine 
continues printing when it detects paper that is 
not matched to your paper setting.
• Off: If a paper mismatch occurs, the message 

remains on the display and the machine 
remains off-line until you insert the correct 
paper.

• On: If the paper is mismatched, an error 
message displays. The machine goes off-line 
for 30 seconds then automatically clears the 
message and continues printing.

Altitude Adj. You can optimize the print quality according to 
your altitude.

Auto CR This option allows you to append the required 
carriage return to each line feed, which is useful 
to the Unix user or DOS user.
Refer to the following samples:

Job Timeout You can set the amount of time a single print job 
is active before it must print. The machine 
handles incoming data as a single job, if it comes 
in within the specified time. When an error 
occurs while processing data from the computer 
and the data flow stops, the machine waits the 
specified amount of time and then cancels 
printing if data flow does not resume. (See page 
3.4 for more information)

Maintenance This menu allows you to maintain consumables 
within the machine and check supplies' life. You 
can clean fuser components. (See page 6.1 for 
more information)

Clear Setting This menu item allows you to restore the 
printer's factory default settings.

Menu Description

Emulation Type You can select the machine language. If the 
languages from the computer and the machine 
are different, the printing quality can not be 
confirmed. It is recommended to set this menu to 
Auto to switch the proper language.

Menu Description

LF LF+CR

 
 AA
     BB
         CC

 
 AA
 BB
 CC
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Setup PCL
This menu sets the PCL emulation configuration. 
You can set the font type, symbol type, lines per 
page, and font size.
• Typeface: You can select the standard font to 

be used in PCL emulation. PCL1~PCL7's 
interval between letters is fixed, and 
PCL8~PCL45's interval is proportional to the 
font type and font size. You can adjust the font 
size of PCL1~PCL7 using the Pitch item, and 
PCL8~PCL45 can do using Point Size item. 
PCL8~PCL56's interval and font size are fixed.

• Symbol: This item selects the symbol set to 
be used in PCL emulation. The symbol is the 
group of numbers, marks, and special signs 
being used when printing letters. Depending 
on the Typeface setting, available symbol sets 
vary.

• Point Size: When you select one between 
PCL8 and PCL45 from the Typeface menu, 
you can determine the font size by setting the 
height of the characters in the font.

• Courier: This item lets you select the version 
of Courier font to use.

• Pitch: When you select one between PCL1 
and PCL7 from the Typeface menu, you can 
determine the font size by setting the number 
of characters that will print in one horizontal 
inch of type. The default value, 10 is the best 
size.

• Lines: This item allows you to set vertical 
spacing from 5 to 128 lines for the default 
paper size. The default number of lines may 
differ according to the paper size and printing 
orientation.

PostScript
This menu provides you with the Print PS Error 
menu item. You can select whether or not your 
printer prints an error list when a PS error 
occurs. Select On to print PS 3 emulation errors. 
If an error occurs, the job stops processing, the 
error message prints, and the printer flushes the 
job. If this menu is set to Off, the job is flushed 
without an indication of the error.

Menu Description Color 

Network 

Menu Description

Custom Color This menu allows you to adjust contrast, color by 
color.
• Default: Optimizes colors automatically.
• Manual Adjust: Allows you to manually adjust 

the color contrast for each cartridge.
It is recommended to use the Default setting for 
best color quality.

Auto Color Reg. The machine can automatically adjust the 
engine color alignment for text or graphics. 

Note 
If you have moved the machine, it is 
strongly recommended to operate this 
menu manually. 

Menu Description

TCP/IP If you are using the TCP/IP protocol for 
networking, select this menu. 
• DHCP: The DHCP server allots an IP address 

to you automatically.
• BOOTP: The BOOTP server allots an IP 

address to you automatically.
• Static: You can enter an IP address, 

subnetmask, and gateway manually.

Ethernet Speed This item allows you to select the communication 
speed for ethernet connection. 

Clear Setting You can clear the network setting you have set.

Network Info. You can print the network configuration report.
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2 Software overview
This chapter gives you an overview of the software that comes with your 
machine. Further details on how to use the software are explained in the 
Software section.

This chapter includes:
• Supplied software
• Printer driver features
• System requirements

Supplied software
You must install the machine software using the supplied CD’s after you 
have set up your machine and connected it to your computer. 

Each CD provides you with the following software:

CD Contents

Printer 
software CD

Windows • Printer driver: Use this driver to 
take full advantage of your 
machine’s features.

• PostScript Printer Description 
(PPD) filea: Use the PostScript 
driver to print documents with 
complex fonts and graphics in the 
PS language.

• Smart Panel: This program allows 
you to monitor the machine’s status 
and alerts you when an error occurs 
during printing.

• User’s Guide in PDF 
• SetIP: Use this program to set your 

machine’s TCP/IP addresses. 
• Adobe Acrobat Reader: The 

application which you can browse 
the user’s guide. 

a. This feature is available with the CLP-660 series only.

Linux • PostScript Printer Descriptiona: 
Use this driver to run your machine 
from a Linux computer and print 
documents.

Macintosh • Postscript Printer Description 
(PPD) filea: Use this file to run your 
machine from a Macintosh computer 
and print documents.

• Smart Panel: This program allows 
you to monitor the machine’s status 
and alerts you when an error occurs 
during printing.

Printer driver features
Your printer drivers support the following standard features:
• Paper source selection
• Paper size, orientation and media type
• Number of copies

Note 
The symbol * denotes an optional menu depending on 
machines.

In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers:

Printer driver (CLP-610 Series)  

Note 
If you want to change the printer language, go to printer 
properties, and change the printer language in Printer tab.  

Feature Windows Linux Macintosh

Printer Languages
SPL, 

PCL5c, 
PCL6

SPL SPL

Color mode O O O

Machine quality option O O O

Poster printing O X X

Multiple pages per sheet 
(N-up)

O O (2, 4) O (2, 4, 6, 
9, 16)

Fit to page printing O X X

Scale printing O X O

Different source for first page O X O

Watermark O X X

Overlay O X X

Duplex O O O



2.2   <Software overview>

Printer driver (CLP-660 Series)  

Note 
If you want to change the printer language, go to printer 
properties, and change the printer language in Printer tab.  

System requirements
Before you begin, ensure that your system meets the following 
requirements:

Windows
Your machine supports the following Windows operating systems. 

Feature Windows Linux Macintosh

Printer Languages
SPL, 

PCL5c, 
PCL6 
(PS)

PS PS

Color mode O O O

Machine quality option O O O

Poster printing O (X) X X

Multiple pages per sheet 
(N-up)

O O (2, 4) O (2, 4, 6, 
9, 16)

Fit to page printing O X X

Scale printing O X O

Different source for first page O (X) X O

Watermark O (X) X X

Overlay O (X) X X

Duplex * O O O

OS
Requirement (recommended)

CPU RAM free HDD 
space

Windows 
2000

Pentium II 400 MHz 
(Pentium III 933 MHz)

64 MB 
(128 MB)

300 MB

Windows 
XP

Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB 
(256 MB)

1.5 GB

Windows 
2003 
Server

Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB 
(512 MB)

1.25 GB to 
2 GB

Note 
• Internet Explorer 5.0 or higher is the minimum requirement for 

all Windows operating systems.
• Users who have an administrator right can install the 

software.

Linux

Macintosh

Windows 
Vista

Pentium IV 3 GHz 512 MB 
(1024 MB)

15 GB

Item Requirements

Operating system • Red Hat 8 ~ 9
• Fedora Core 1 ~ 4
• Mandrake 9.2 ~ 10.1
• SuSE 8.2 ~ 9.2

CPU Pentium IV 1 GHz or higher

RAM 256 MB or higher

free HDD space 1 GB or higher

Software • Linux Kernel 2.4 or higher
• Glibc 2.2 or higher
• CUPS

Item Requirements

Operating system Macintosh 10.3 ~ 10.5 (CLP-610 series)
Macintosh 10.1 ~ 10.5 (CLP-660 series)

CPU Intel processor 
Power PC G4 /G5 

RAM 512 MB for an Intel-based Mac,            
128 MB for a Power PC based Mac 

free HDD space 1 GB 

Connection USB interface or Network interface 

OS
Requirement (recommended)

CPU RAM free HDD 
space
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3 Getting Started
This chapter gives you step-by-step instructions for setting up the 
machine.

This chapter includes:
• Setting up the hardware
• Setting up the network
• Installing the software
• Printer's basic settings

Setting up the hardware
This section shows the steps to set up the hardware which is explained 
in the Quick Install Guide. Make sure you read Quick Install Guide and 
complete following steps.

1 Select a stable location. 

Select a level, stable place with adequate space for air circulation. 
Allow extra space to open covers and trays. 

The area should be well-ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to 
the edge of your desk or table. 

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to 
the altitude setting to optimize your printing. See page 3.4 for more 
information.

Place the machine on a flat and stable surface, not letting it tilt more 
than 2 mm (0.08 inches). Otherwise, it may affect the print quality. 

2 Unpack the machine and check all the enclosed items.

3 Remove the tape holding the machine tightly.

4 Install all four of the toner cartridges.

5 Load paper. (See "Loading paper" on page 4.4.)

6 Make sure that all the cables are connected to the machine. 

7 Turn the machine on. 

Caution
When you move the machine, do not tilt or turn it upside 
down. Otherwise, the inside of the machine may be 
contaminated by toner, which can cause damage to the 
machine or bad print quality.

Setting up the network
You need to set up the network protocols on the machine to use it as your 
network printer. You can set up the basic network settings with the 
machine’s control panel.

Note
• If you want to use the USB cable, connect between a computer 

and your machine. Then, refer to the software installation in 
Software section.
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Supported operating systems
The following table shows the network environments supported by the 
machine: 

Configuring network protocol via the machine
You can set up TCP/IP Network parameters, follow the steps listed below. 

Note
If you want to setup DHCP network protocol, go to the http://
developer.apple.com/networking/bonjour/download/, select the 
program Bonjour for Windows due to your computer operating 
system, and install the program. This program will allow you to 
fix the network parameter automatically. Follow the instruction in 
the installation window. This program does not support Linux.

1 Make sure your machine is connected to the network with an RJ-45 
Ethernet cable.

2 Make sure you have turned on the machine.

3 Press Menu on the control panel, until you see Network on the 
bottom line of the display. 

4 Press OK to access the menu.

5 Press the left/right arrow until TCP/IP displays. 

6 Press OK.

7 Press the left/right arrow until Static displays.

8 Press OK.

9 Press the left/right arrow until IP Address displays.

10 Press OK.

11 Enter IP address. 
a.Press the left/right arrow to enter a number between 0 and 255.
b.Press OK. 
c.Repeat these steps to complete the address.

12 Press Back to go to the upper level. 

Item Requirements

Network interface 10/100 Base-TX

Network operating 
system

Windows 2000/XP/2003/Vista
Various Linux OS
Macintosh 10.3 ~ 10.5 (CLP-610 series)
Macintosh 10.1 ~ 10.5 (CLP-660 series)

Network protocols TCP/IP

Dynamic addressing 
server

DHCP, BOOTP

13 Press the left/right arrow until Subnet Mask displays.

14 Press OK.

15 Enter Subnet Mask. 
a.Press the left/right arrow to enter a number between 0 and 255.
b.Press OK.
c.Repeat these steps to complete Subnet Mask.

16 Press Back to go to the upper level. 

17 Press the left/right arrow until Gateway displays.

18 Press OK.

19 Enter Gateway. 
a.Press the left/right arrow to enter a number between 0 and 255.
b.Press OK.
c.Repeat these steps to complete Gateway.

Note
Contact the network administrator if you are not sure how to 
configure.

Note
You can also set up the network settings through the network 
administration programs. Refer to the user’s guide on the 
Network Utilities CD that came with your machine.
• SyncThru™ Web Admin Service: Web-based printer 

management solution for network administrators. SyncThru™ 
Web Admin Service provides you with an efficient way of 
manageing network devices and lets you remotely monitor and 
troubleshoot network machines from any sith with corporate 
internet access. Download this program from
  http://solution.samsungprinter.com.

• SyncThru™ Web Service: Web server embedded on your 
network print server, which allows you to:
-  Configure the network parameters necessary for the machine 

to connect to various network environments.
-  Customize machine settings.

• SetIP: Utility program allowing you to select a network interface 
and manually configure the IP addresses for use with the TCP/
IP protocol. See Using SetIP program on page 3.5.

http://solution.samsungprinter.com.
http://solution.samsungprinter.com.
http://developer.apple.com/networking/bonjour/download/
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Installing the software
You have to install the machine software for printing. The software 
includes drivers, applications, and other user friendly programs. 

Note
• The following procedure is for when you use the machine as 

a network machine. If you want to connect a machine with a 
USB cable, refer to the Software section.

• The following procedure is based on the Windows XP 
operating system. The procedure and popup window which 
appears during the installation may differ depending on the 
operating system, the printer feature, or the interface in use.
(See Software section.)

1 Make sure that the network setup for your machine is completed. 
(See "Setting up the network" on page 3.1.) All applications should 
be closed on your computer before beginning installation.

2 Insert the Printer Software CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation window 
appears.

If the installation window does not appear, click Start > Run. Type 
X:\Setup.exe, replacing “X” with the letter which represents your 
drive and click OK.

If you use Windows Vista, click Start > All Programs > 
Accessories > Run, and type X:\Setup.exe. 

3 Click Next. 

• The window above may slightly differ, if you are reinstalling the 
driver.

• View User’s Guide: Allows you to view the User’s Guide. If your 
computer does not have Adobe Acrobat, click on this option and it 
will automatically install Adobe Acrobat Reader for you, and then 
open the User’s Guide.

4 Select Typical installation for a network printer, and then click 
Next. 

5 The list of machines available on the network appears. Select the 
printer you want to install from the list and then click Next. 

• If you do not see your machine on the list, click Update to refresh 
the list, or select Add TCP/IP Port to add your machine to the 
network. To add the machine to the network, enter the port name 
and the IP address for the machine.
To verify your machine’s IP address or the MAC address, print a 
Network Configuration page. (See "Printing a machine 
configuration report" on page 6.1.)

• To find a shared network printer (UNC Path), select Shared 
Printer [UNC] and enter the shared name manually or find a 
shared printer by clicking the Browse button.

Note
If you are not sure of the IP address, contact your network 
administrator or print network information. (See "Printing a 
machine configuration report" on page 6.1.)

6 After the installation is finished, a window appears asking you to 
print a test page and to register yourself as a user of Samsung 
machines in order to receive information from Samsung. If you so 
desire, select the corresponding checkbox and click Finish.
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Note
•If your machine does not work properly after the 
installation, try to reinstall the printer driver. See Software 
section.
•When the printer driver is in installation process, the driver 
installer detects the locale information of your operating 
system, and sets the default paper size for your machine. If 
you use the different Windows locale, you must change the 
paper size of your machine for matching your commonly 
used paper size. Go to the printer properties to change the 
paper size after installation completes. 

Printer's basic settings
After installation is complete, you may want to set the printer's default 
settings. Refer to the next section if you would like to set or change 
values.

Altitude Setting after Software Installation
The print quality is affected by atmospheric pressure, which is determined 
by the height of the machine above sea level. The following information 
will guide you on how to set your machine to the best print quality or best 
quality of print.

Before you set the altitude value, find the altitude where you are using the 
machine. 

1 Ensure that you have installed the printer driver with the provided     
Printer Software CD. 

2 Double-click the Smart Panel icon on the Windows task bar (or 
Notification Area in Linux). You can also click Smart Panel on the 
status bar in Mac OS X.

3 Click Printer Setting.

High 31

Normal4

Value

2 High 2

3 High 1

4 Click Setting > Altitude Adjustment. Select the appropriate value 
from the dropdown list, and then click Apply. 

Changing the display language
To change the language that appears on the display, refer to the following 
steps.

1 Press Menu on the control panel until you see System Setup on 
the bottom line of the display.

2 Press OK to access System Setup.

3 Press the left/right arrow until Language displays.

4 Press OK.

5 Press the left/right arrow until the language you want displays.

6 Press OK.

7 Press Stop to return to machine ready mode.

Setting job timeout
1 Press Menu on the control panel until you see System Setup on 

the bottom line of the display.

2 Press OK to access System Setup.

3 Press the left/right arrow until Job Timeout displays.

4 Press OK.

5 Press the left/right arrow to select the amount of time the machine 
will wait. 

6 Press OK.

7 Press Stop to return to machine ready mode.

Note
If your machine is connected to a network, SyncThru Web 
Service screen appears automatically. Click Printer Setting > 
Setup (or Machine Setup) > Altitude Adj. Select the 
appropriate altitude value, and then click Apply.



3.5   <Getting Started>

Using power saving feature
The machine provides power saving features. When the machine is not 
in use, you can save electricity with the provided power save mode. Set 
the specific time the machine goes to the power save mode. 

1 Press Menu on the control panel until you see System Setup on 
the bottom line of the display.

2 Press OK to access System Setup.

3 Press the left/right arrow until Power Save displays.

4 Press OK.

5 Press the left/right arrow to select the amount of time. 

6 Press OK.

7 Press Stop to return to machine ready mode.

Setting the default paper size and type
You can select the paper size you would like to keep for printing job.

Note
For detailed information on the Custom paper size setting and 
the paper type setting, see "Setting the paper size and type" on 
page 4.7.

1 Press Menu on the control panel until you see Paper on the bottom 
line of the display.

2 Press OK to access the paper setup.

3 Press the left/right arrow until Paper Size displays.

4 Press OK.

5 Press the left/right arrow to select the paper size such as A4, Letter 
or Custom. 

6 Press OK.

7 Press Stop to return to machine ready mode.

Setting the default tray 
If you want to select the particular tray for the print job, use the Paper 
Source feature. 

1 Press Menu on the control panel until you see Paper on the bottom 
line of the display.

2 Press OK to access the paper setup.

3 Press the left/right arrow until Paper Source displays.

4 Press OK.

5 Press the left/right arrow to select the paper tray, such as Tray 1, 
Tray 2, MP Tray, Manual Feeder or Auto. 

Note
If you set this menu to Auto, an additional menu, Tray 
Chaining appears. With Tray Chaining, the machine finds a 
secondary available tray to continue a printing job in case the 
primary tray, usually tray 1, is unavailable (or not ready).

6 Press OK.

7 Press Stop to return to machine ready mode.

Changing the font setting
Your machine has preset the font for your region or country. If you want 
to change the font which you prefer or set the font under special condition 
such as the DOS environment, you can change the font setting as 
follows: 

1 Press Menu on the control panel until you see Emulation feature.

2 Press OK to access the font setting.

3 Press the left/right arrow until Setup displays.

4 Press the left/right arrow until PCL displays.

5 Press the left/right arrow until Symbol displays.

6 Press the left/right arrow until your preferred font displays.

7 Press OK.

8 Press Stop to return to machine ready mode.

Note
Following information shows the proper font list for 
corresponding languages.
•Russian: CP866, Cyrillic
•Hebrew: 15Q, 8H, 0H  (Israel only)
•Greek: GREEK, PC737
•Arabic & Farsi: ARABIC8, WINARABIC, PC864, FARSI, 
ISOARABIC
•OCR : OCR-A, OCR-B

Using SetIP program 
This program is for the network IP setting using the MAC address which 
is the hardware serial number of the network printer card or interface. 
Especially, it is for the network administrator to set several network IPs at 
the same time. 

1 Insert the driver CD provided along with your machine. 

2 Start Windows Explorer and open the X drive. (X represents your 
CD-ROM drive.)

3 Double click Application > SetIP. 

4 Open the language folder you want to use.

5 Double click Setup.exe to install this program. 
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6 From the Windows Start menu, select Programs > Samsung 
Network Printer Utilities > SetIP.

7 Select the name of your printer and click “  ”. 

Note
If you cannot find your printer name click “  ” to refresh the 
list.

8 Enter the network card’s MAC address, IP address, subnet mask, 
default gateway, and then click Apply.

Note
If you do not know the network card's MAC address, print the 
machine's network information report.

9 Click OK to confirm the settings.

Click Exit to close the SetIP program.
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4 Selecting and loading print 
media

This chapter introduces you how select and load print media for your 
machine.

This chapter includes:
• Selecting print media
• Loading paper
• Setting the paper size and type

Selecting print media
You can print on a variety of print media, such as plain paper, envelopes, 
and labels. Always use print media that meet the guidelines for use with 
your machine. Print media that does not meet the guidelines outlined in 
this user’s guide may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.

Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described later in this section.
• Desired outcome: The print media you choose should be appropriate 

for your project.
• Brightness: Some print media are whiter than others and produce 

sharper, more vibrant images.
• Surface smoothness: The smoothness of the print media affects how 

crisp the printing looks on the paper.

Caution 
Using print media that does not meet these specifications may 
cause problems, requiring repairs. Such repairs are not covered 
by Samsung’s warranty or service agreements.

Note
• Some print media may meet all of the guidelines in this section 

and still not produce satisfactory results. This may be the result 
of improper handling, unacceptable temperature and humidity 
levels, or other variables over which Samsung has no control.

• Before purchasing large quantities of print media, ensure that it 
meets the requirements specified in this user’s guide. 

Guidelines for selecting and storing print media
When selecting or loading paper, envelopes, or other print materials, 
keep these guidelines in mind:
• Always use print media that conforms with the specifications listed on 

page 4.2.
• Attempting to print on damp, curled, wrinkled, or torn paper can cause 

paper jams and poor print quality.
• For the best print quality, use only high quality copier grade paper 

specifically recommended for use in laser machines. 
• Avoid using the following media types:

- Paper with embossed lettering, perforations, or a texture that is too 
smooth or too rough

- Erasable bond paper
- Multi-paged paper
- Synthetic paper and thermally reactive paper
- Carbonless paper and Tracing paper. 
Use of these types of paper could result in paper jams, chemical 
smells, and damage to your machine.

• Store print media in its ream wrapper until you are ready to use it. 
Place cartons on pallets or shelves, not on the floor. Do not place 
heavy objects on top of the paper, whether it is packaged or 
unpackaged. Keep it away from moisture or other conditions that can 
cause it to wrinkle or curl.

• Store unused print media at temperatures between 15 °C and 30 °C. 
The relative humidity should be between 10% and 70%.

• Store unused print media in a moisture-proof wrap, such as a plastic 
container or bag, to prevent dust and moisture from contaminating 
your paper.

• Load special media types one sheet at a time through the multi-
purpose tray to avoid paper jams.

• To prevent print media, such as label sheets, from sticking together, 
remove them as they print out.
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Specifications on print media

Type Size Dimensions Weighta

a. If media weight is over 105 g/m2 (28 lb bond), use the multi-purpose tray.

Capacityb

b. Maximum capacity may differ depending on media weight, thickness, and environmental conditions.

Plain paper Letter 216 x 279 mm (8.5 x 11 inches) • 60 to 105 g/m2 (16 to 28 lb 
bond) for the tray

• 60 to 163 g/m2 (16 to 43 lb 
bond) for the multi-purpose 
tray

• 250 sheets of 75 g/m2 

(20 lb bond) paper for the 
tray

• 100 sheets of 75 g/m2 
(20 lb bond) in the multi-
purpose tray

• 500 sheets of 75 g/m2 
(20 lb bond) paper for 
optional tray

Legal 216 x 356 mm (8.5 x 14 inches)

Folio 216 x 330 mm (8.5 x 13 inches)

A4 210 x 297 mm (8.26 x 11.69 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

JIS B5 182 x 257 mm (7.16 x 10.11 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.82 x 8.26 inches) • 60 to 105 g/m2 (16 to 28 lb 
bond) for the tray

• 60 to 163 g/m2 (16 to 43 lb 
bond) for the multi-purpose 
tray

• 150 sheets of 75 g/m2 

(20 lb bond) paper for the 
tray

• 100 sheets of 75 g/m2 
(20 lb bond) in the multi-
purpose tray

Statement 140 x 216 mm (5.5 x 8.5 inches)

A6 105 x 148 mm (4.13 x 5.82 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches) 75 to 105 g/m2 (20 to 28 lb 
bond)

10 sheets of 75 g/m2 (20 lb 
bond) in the multi-purpose 
trayEnvelope No. 9 98 x 225 mm (3.87 x 8.87 inches)

Envelope No. 10 105 x 241 mm (4.12 x 9.5 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.37 x 9.01 inches)

Envelope C6 114 x 162 mm (4.48 x 6.38 inches)

Envelope 6 3/4 92 x 165 mm (3.62 x 6.5 inches)

Labels Letter, Legal, Folio, 
A4, JIS B5, ISO B5, 
Executive, A5, A6, 
Oficio, Statement

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lb 
bond)

10 sheets of 75 g/m2 (20 lb 
bond) paper for the multi-
purpose tray

Card stock Letter, Legal, Folio, 
A4, JIS B5, ISO B5, 
Executive, A5, A6, 
Oficio, Statement

Refer to the Plain paper section 90 to 163 g/m2 (24 to 43 lb 
bond)

10 sheets of 75 g/m2 (20 lb 
bond) paper for the multi-
purpose tray

Minimum size (custom) 76 x 127 mm (3 x 5 inches) 60 to 163 g/m2 (16 to43 lb bond) 

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)
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Media sizes supported in each mode

Guidelines for special print media

Mode Size Weight Source

Single side 
printing

All sizes 
supported by 
the machine

All weights 
supported by 
the machine

• tray 1
• optional tray
• multi-purpose tray

Duplex 
printinga

a. 75 to 105 g/m2 (20 ~ 28 lb bond) only, and this feature is supported in 
CLP-6xxND.

Letter, A4, 
Legal, Folio, 
Oficio

75 to 90 g/m2 
(20 to 24 lb 
bond)

• tray 1
• optional tray
• multi-purpose tray

Media type Guidelines

Envelopes • Successful printing on envelopes depends upon 
the quality of the envelopes. When selecting 
envelopes, consider the following factors:
- Weight: The weight of the envelope paper 

should not exceed 90 g/m2 or jamming may 
occur.

- Construction: Prior to printing, envelopes 
should lie flat with less than 6 mm curl, and 
should not contain air.

- Condition: Envelopes should not be wrinkled, 
nicked, or otherwise damaged.

- Temperature: You should use envelopes that 
are compatible with the heat and pressure of 
the machine during operation.

• Use only well-constructed envelopes with sharp 
and well creased folds.

• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, 

windows, coated lining, self-adhesive seals, or 
other synthetic materials.

• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope 

extends all the way to the corner of the 
envelope.

Acceptable

Unacceptable

• Envelopes with a peel-off adhesive strip or with 
more than one flap that folds over to seal must 
use adhesives compatible with the machine’s 
fusing temperature for 0.1 second. Check your 
machine’s specification to view the fusing 
temperature, see page 10.1. The extra flaps and 
strips might cause wrinkling, creasing, or jams, 
and may even damage the fuser.

• For the best print quality, position margins no 
closer than 15 mm from the edges of the 
envelope.

• Avoid printing over the area where the 
envelope’s seams meet.

Labels • To avoid damaging the machine, use only labels 
designed for use in laser machines.

• When selecting labels, consider the following 
factors:
- Adhesives: The adhesive material should be 

stable at your machine’s fusing temperature. 
Check your machine’s specification to view the 
fusing temperature, see page 10.1.

- Arrangement: Only use labels with no 
exposed backing between them. Labels can 
peel off sheets that have spaces between the 
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with 
no more than 13 mm of curl in any direction.

- Condition: Do not use labels with wrinkles, 
bubbles, or other indications of separation.

• Make sure that there is no exposed adhesive 
material between labels. Exposed areas can 
cause labels to peel off during printing, which 
can cause paper jams. Exposed adhesive can 
also cause damage to machine components.

• Do not run a sheet of labels through the machine 
more than once. The adhesive backing is 
designed for only a single pass through the 
machine.

• Do not use labels that are separating from the 
backing sheet or are wrinkled, bubbled, or 
otherwise damaged.

Card stock or 
custom-sized 
materials

• Do not print on media smaller than 76 mm wide 
or 356 mm long.

• In the software application, set margins at least 
6.4 mm away from the edges of the material.

Media type Guidelines
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Caution 
Using photographic paper or coated paper may cause 
problems, requiring repairs. Such repairs are not covered by 
Samsung’s warranty or service agreements.

Preprinted 
paper

• Letterhead must be printed with heat-resistant 
ink that will not melt, vaporize, or release 
hazardous emissions when subjected to the 
printer’s fusing temperature for 0.1 second. 
Check your machine’s specification to view the 
fusing temperature, see page 10.1.

• Letterhead ink must be non-flammable and 
should not adversely affect printer rollers.

• Forms and letterhead should be sealed in a 
moisture-proof wrapping to prevent changes 
during storage.

• Before you load preprinted paper, such as forms 
and letterhead, verify that the ink on the paper is 
dry. During the fusing process, wet ink can come 
off preprinted paper, reducing print quality.

Media type Guidelines Loading paper

In the tray
Load the print media you use for the majority of your print jobs in tray 1. 
Tray 1 can hold a maximum of 250 sheets of 75 g/m2 (20 lb bond) plain 
paper. 

You can purchase an optional tray and attach it below the standard tray 
to load an additional 500 sheets of paper. (See "Accessories" on 
page 8.1.)

Loading paper in the tray 1 or optional tray

1 To load paper, pull and open the paper tray and place paper with the 
side you want to print facing up.

2 After loading paper, set the paper type and size for the tray 1. See 
Software section for PC-printing.

Note
• If you experience problems with paper feed, place one sheet at 

a time in the multi-purpose tray.
• You can load previously printed paper. The printed side should 

be facing up with an uncurled edge at the front. If you 
experience problems with paper feed, turn the paper around. 
Note that print quality is not guaranteed. 

Full

Empty
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Changing the size of the paper in the paper tray
To load longer sizes of paper, such as Legal-sized paper, you need to 
adjust the paper guides to extend the paper tray.

1 Adjust the paper length guide to the desired paper length. It is 
preset to Letter or A4 size depending on the country. 

1 tray extend lever
2 paper length guide
3 paper width guide

2 After inserting paper into the tray, while pinching the paper width 
guide as shown, move it toward the stack of paper until it lightly 
touches the side of the stack. Do not press the guide too tightly to 
the edge of the paper; the guide may bend the paper. 

When you use legal-sized paper, you need to extend the length of 
the tray.

3 Press and hold the green lever on the back of the tray, when you are 
holding the lever, extend the tray to the corresponding position. 

4 Load the paper into the tray. 

5 Place the tray into the machine.

6 Set the paper size from your computer. (See page 4.7)

Note
• Do not push the paper width guides far enough to cause the 

materials to warp.
• If you do not adjust the paper width guides, it may cause paper 

jams.

tray extend lever
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In the multi-purpose tray
The multi-purpose tray can hold special sizes and types of print material, 
such as postcards, note cards, and envelopes. It is useful for single page 
printing on letterhead or colored paper.

Tips on using the multi-purpose tray
• Load only one size of print media at a time in the multi-purpose tray.
• To prevent paper jams, do not add paper when there is still paper in 

the multi-purpose tray. This also applies to other types of print media.
• Print media should be loaded face down with the top edge going into 

the multi-purpose tray first and be placed in the center of the tray.
• Always load only the specified print media to avoid paper jams and 

print quality problems. (See "Selecting print media" on page 4.1.)
• Flatten any curl on postcards, envelopes, and labels before loading 

them into the multi-purpose tray.

To load paper in the multi-purpose tray:

1 Hold the handle of multi-purpose tray and pull it down to open.

2 If you are using paper, flex or fan the edge of the paper stack to 
separate the pages before loading.

3 Load the paper.

Note 
If you want to load the used paper which one side has been 
printed already, place the paper with the used side facing 
up.

4 Squeeze the multi-purpose tray paper width guides and adjust them 
to the width of the paper. Do not force too much, or the paper will be 
bent, which will result in a paper jam or skew.
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5 After loading paper, set the paper type and size for the multi-
purpose tray. See Software section for PC-printing.

Note 
The settings made from the printer driver override the 
settings on the control panel.

6 After printing, close the multi-purpose tray.

Note
Depending on the media type you are using, keep the following 
loading guidelines:
• Envelopes: Place an envelope's flap side up, stamp area 

bottom right.
• Labels: Print side up and top short edge entering the machine 

first.
• Preprinted paper: Place the design side down with top-edge 

toward the machine. 
• Card stock: Print side up and the short edge entering the 

machine first.
• Previously printed paper: Previously printed side up with an 

uncurled edge toward the machine.

Setting the paper size and type
The settings you change remain in effect only while you are using the 
current program. To make your changes permanent, make them in the 
Printers folder.

Note 
The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.

1 Click the Start button on the computer screen.

2 Select Printers and Other Hardwares.

3 Select Printers and Faxes.

4 Right-click on the printer driver icon and select Printing 
Preferences.

5 Click the Paper tab, and change the settings on Paper Options.

6 Click OK.



5.1   <Basic printing>

5 Basic printing
This chapter explains common printing tasks. 

Printing a document
Your machine allows you to print from various Windows, Macintosh, or 
Linux applications. The exact steps for printing a document may vary 
depending on the application you use.

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is displayed. It 
may look slightly different depending on your application.

3 Select your printer driver from the Selet Printer drop-down list.

4 To start the print job, click OK or Print in the Print window.

For details about printing, see Software section.

Canceling a print job
If the print job is waiting in a print queue or print spooler, such as the 
printer group in Windows, delete the job as follows:

1 Click the Windows Start menu.

2 For Windows 2000, select Settings and then Printers.

For Windows XP/2003, select Printers and Faxes.

For Windows Vista, select Control Panel > Hardware and Sound 
> Printers.

3 Double-click the Samsung CLP-6xx Series icon. (Or Samsung 
CLP-6xx Series PS)

4 From the Document menu, select Cancel.

Note
You can also access this window by simply double-clicking the 
printer icon at the bottom right corner of the Windows desktop.

You can also cancel the current job by pressing Stop on the control panel.
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6 Maintenance
This chapter provides information for maintaining your machine and the 
toner cartridge.

This chapter includes:
• Printing a machine configuration report
• Printing a network report
• Monitoring the supplies' life
• Cleaning your machine
• Maintaining the cartridge
• Redistributing toner
• Replacing the toner cartridge
• Replacing the paper transfer belt
• Maintenance parts
• Managing your machine from the website

Printing a machine configuration report
You can print the machine's information.

1 Press Menu on the control panel until you see Information on the 
bottom line of the display. 

2 Press OK.

3 Press the left/right arrow until Configuration displays.

4 Press OK.

5 The display shows Print?, then press OK to print the configuration 
report.

Printing a network report
You can print the machine's network information such as the protocol type 
you set, IP address and so forth.

1 Press Menu on the control panel until you see Network on the 
bottom line of the display. 

2 Press OK.

3 Press the left/right arrow button until Network Info. displays.

4 Press OK.

5 The display shows Print?, then press OK to print the configuration 
report.

Monitoring the supplies' life
If you want to view the supply life indicators, follow the next step.

1 Press Menu on the control panel until you see System Setup on the 
bottom line of the display. 

2 Press OK.

3 Press the left/right arrow until Maintenance displays.

4 Press OK.

5 Press the left/right arrow until Supplies Life displays.

6 Press OK.

7 The display shows two options as you press the left/right arrow 
button. 
• Total: displays the total number of pages printed.
• Toner Remains: displays how much toner remains in the 

cartridge.

8 When you select the option, press OK to browse the life.

Cleaning your machine
To maintain print quality, follow the cleaning procedures below each time 
the toner cartridge is replaced.

Caution
• Cleaning the machine cabinet with cleaning materials that 

contain large amounts of alcohol, solvent, or other strong 
substances can discolor or damage the cabinet.

• If your machine or its surrounding is contaminated with toner, 
we recommend you to use a cloth or tissue dampened with 
water to clean it. If you use a vacuum cleaner, toner blown 
into the air may be harmful to you. 

Cleaning the outside
Clean the machine cabinet with a soft, lint-free cloth. You can dampen the 
cloth slightly with water, but be careful not to let any water drip onto or into 
the machine.

Cleaning the inside
During the printing process, paper, toner and dust particles can 
accumulate inside the machine. This buildup can cause print quality 
problems, such as toner specks or smearing. Cleaning the inside of the 
machine clears or reduces these problems. Contact a service 
representative to clean the parts inside the machine.

1 Power off the machine and unplug the power cable.
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2 Using the handle, completely open the front cover.

Caution
• Do not touch the green surface, the OPC drum or the front of 

the toner cartridge, with your hands or any other material. 
Use the handle on each cartridge in order to avoid touching 
this area.

• Be careful not to scratch the surface of the paper transfer 
belt.

• If you leave the front cover open for more than a few minutes, 
the OPC drum can be exposed to light. This will cause 
damage to the OPC drum. Cover the toner cartridge’s OPC 
drum with the some paper could avoid damaging it from the 
light while you clean the inside.

3 Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the machine.

Caution
If you open the front door, be careful not to touch the 
underneath of the control panel (the lower part of the fuser unit). 
The temperature of the fuser unit might be high and could 
damage your skin.

Note
When you open the front door and work inside the machine, it is 
highly recommend that you remove the paper transfer belt first. 
Because the work you do could contaminate the paper transfer 
belt.

4 Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the 
machine.

5 Locate the long strip of glass (LSU) inside the cartridge 
compartment, and gently swab the glass to see if dirt turns the white 
cotten black.
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6 With a dry lint-free cloth, wipe away any dust and spilled toner from 
the toner cartridges area and their cavities. 

Note
If toner gets on your clothing, wipe it off with a dry
cloth and wash it in cold water. Hot water sets toner into
fabric.

7 Reinstall all the compartments into the machine, and close the front 
door.

Maintaining the cartridge

toner cartridge storage
To get the most from the toner cartridge, keep the following guidelines in 
mind:
• Do not remove the toner cartridge from its package until ready for use. 
• Do not refill the toner cartridge. The machine warranty does not cover 

damage caused by using a refilled cartridge.
• Store toner cartridges in the same environment as your machine.
• To prevent damage to the toner cartridge, do not expose it to light for 

more than a few minutes.

Expected cartridge life
The life of the toner cartridge yield depends on the amount of toner that 
print jobs require. The actual number may also be different depending on 
the print density of the pages you print on, and the number of pages may 
be affected by operating environment, printing interval, media type, and 
media size. If you print a lot of graphics, you may need to change the 
cartridge more often.

Redistributing toner
When a toner is low, faded or light areas may appear. It is possible that 
colored images may be printed with incorrect colors due to flawed mixing 
of toner colors when one of the colored toner cartridges is low on toner. 
You can temporarily improve print quality by redistributing the toner.
• The toner-related message saying that the toner is low may appear on 

the display.
• The SmartPanel program window appears on the computer telling you 

which color cartridge is low on toner.

1 Using the handle, completely open the front cover.

Caution
• Do not touch the green surface, the OPC drum or the front of 

the toner cartridge, with your hands or any other material. 
Use the handle on each cartridge in order to avoid touching 
this area.

• Be careful not to scratch the surface of the paper transfer 
belt.

• If you leave the front cover open for more than a few minutes, 
the OPC drum can be exposed to light. This will cause 
damage to the OPC drum. Close the front cover should the 
installation need to be halted for any reason.
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2 Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the machine.

Caution
If you open the front door, be careful not to touch the 
underneath of the control panel (the lower part of the fuser unit). 
The temperature of the fuser unit might be high and could 
damage your skin.

Note
When you open the front door and work inside the machine, it is 
highly recommend that you remove the paper transfer belt first. 
Because the work you do could contaminate the paper transfer 
belt.

3 Holding both handles on the toner cartridge, thoroughly rock it from 
side to side to redistribute the toner.

Note
If toner gets on your clothing, wipe it off with a dry
cloth and wash it in cold water. Hot water sets toner into
fabric.

4 Slide the toner cartridge back into the machine.

5 Close the front cover. Make sure the cover is securely latched.

Caution
If the front cover is not completely closed, the machine will not 
operate.

Replacing the toner cartridge
The machine uses four colors and has a different toner cartridge for each 
one: yellow (Y), magenta (M), cyan (C), and black (K).
• The status LED and the toner-related message on the display indicate 

which individual toner cartridge should be replaced.

At this stage, the toner cartridge needs to be replaced. Check the type of 
toner cartridge for your machine. (See "Supplies" on page 8.1.)

1 Turn the machine off, then wait a few minutes for the machine to 
cool.

2 Using the handle, completely open the front cover. 

Caution
• Do not touch the green surface, the OPC drum or the front of 

each toner cartridge, with your hands or any other material. 
Use the handle on each cartridge in order to avoid touching 
this area.

• Be careful not to scratch the surface of the paper transfer 
belt.

• If you leave the front cover open for more than a few minutes, 
the OPC drum can be exposed to light. This will cause 
damage to the OPC drum. Close the front cover should the 
installation need to be halted for any reason.
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3 Grasp the handles on the empty toner cartridge and pull to remove 
the cartridge from the machine.

Caution
If you open the front door, be careful not to touch the 
underneath of the control panel (the lower part of the fuser unit). 
The temperature of the fuser unit might be high and could 
damage your skin.

Note
When you open the front door and work inside the machine, it is 
highly recommend that you remove the paper transfer belt first. 
Because the work you do could contaminate the paper transfer 
belt.

4 Take a new toner cartridge out of its package.

Caution
• Don't use sharp objects, such as a knife or scissors, to open 

the toner cartridge package. You could damage the surface of 
the toner cartridge.

• To prevent damage, do not expose the toner cartridge to light 
for more than a few minutes. Cover it with a piece of paper to 
protect it if necessary.

5 Holding both handles on the toner cartridge, thoroughly rock it from 
side to side to evenly distribute the toner. 

6 Place the toner cartridge on a flat surface, as shown, and remove 
the paper covering the toner cartridge by removing the tape.

Note
If toner gets on your clothing, wipe it off with a dry cloth and 
wash it in cold water. Hot water sets toner into fabric.

7 Make sure the color of the toner cartridge matches the color slot and 
then grasp the handles on the toner cartridge. Insert the cartridge 
until it clicks into place.

8 Close the front cover. Make sure the cover is securely latched, and 
then turn the machine on.

Caution
If the front cover is not completely closed, the machine will not 
operate.
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Replacing the paper transfer belt
The life of the paper transfer belt is approximately 50,000 black and color 
pages. After the life span of the paper transfer belt is complete, you have 
to replace it.
• The transfer belt-related message appears on the display, telling it's 

time for a replacement.
• The SmartPanel program window appears on the computer telling you 

the paper transfer belt needs to be replaced.

Note
The life span of the paper transfer belt may be affected by 
operating environment, printing interval, media type, and media 
size.

1 Turn the machine off, then wait a few minutes for the machine to 
cool.

2 Using the handle, completely open the front cover.

Caution
Be careful not to scratch the surface of the paper transfer belt.

3 Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the 
machine.

4 Take a new paper transfer belt out of its package.

Caution
• Don't use sharp objects, such as a knife or scissors, to open 

the paper transfer belt package. You could damage the 
surface of the paper transfer belt.

• Be careful not to scratch the surface of the paper transfer 
belt.

5 Holding the handle on the new paper transfer belt, align it with the 
slots on the inside of the front cover.
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6 Lower the paper transfer belt until it is parallel with the front cover 
and firmly seated. 

7 Close the front cover firmly.

Caution
If the front cover is not completely closed, the machine will not 
operate.

8 Turn the machine on.

Maintenance parts
To avoid print quality and paper feed problems resulting from worn parts, 
and to maintain your machine in top working condition, the following items 
will need to be replaced after the specified number of pages, or when the 
life span of each item has expired. 

We highly recommend that this maintenance be performed by an 
authorized service provider, dealer or the retailer where you bought the 
machine. The warranty does not cover the replacement of the 
maintenance parts after their lifespan.

Managing your machine from the website
If you have connected your machine to a network and set up TCP/IP 
network parameters correctly, you can manage the machine via 
Samsung’s SyncThru™ Web Service, an embedded web server. Use 
SyncThru™ Web Service to:
• View the device information and check its current status.
• Change TCP/IP parameters and set up other network parameters.
• Change the printer properties.
• Set the machine to send email notifications and update you on the 

machine’s status.
• Get support for using the machine.

To access SyncThru™ Web Service:

1 Start a web browser, such as Internet Explorer, from Windows.

2 Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

Your machine’s embedded website opens.

Items Yield (Average)

Multi-purpose tray friction 
pad 

Approximately 70,000 pages 

Multi-purpose tray pick up 
roller

Approximately 70,000 pages

Fuser unit Approximately 100,000 pages

Paper pick up roller Approximately 70,000 pages

FCF friction pad Approximately 70,000 pages
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7 Troubleshooting
This chapter gives helpful information on what to do if you encounter a 
problem.

This chapter includes:
• Tips for avoiding paper jams
• Clearing paper jams
• Understanding display messages
• Solving other problems

Tips for avoiding paper jams
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, follow the steps outlined on page 7.1. 
• Follow the procedures on page 4.4. Ensure that the adjustable guides 

are positioned correctly.
• Do not overload the tray. Ensure that the paper level is below the 

paper capacity mark on the inside of the tray.
• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media. (See "Setting the paper size and 

type" on page 4.7.)

Clearing paper jams
When a paper jam occurs, the warning message appears on the display 
screen. Refer to the table below to locate and clear the paper jam.

Message Location of jam Go to

MP Tray 
Paper Jam 0

In the multi-purpose tray Page 7.3

Tray 2 
Paper Jam 0

In the optional tray Page 7.6

Paper Jam 0
Open/Close Door

In the paper feed area and 
inside the machine

Page 7.1, 
Page 7.4

Paper Jam 1
Open/Close Door

Inside the machine Page 7.1, 
Page 7.4

Paper Jam 2
Check Inside

Inside the machine and in the 
exit area

Page 7.1, 
Page 7.5

Duplex Jam 0
Check Inside*

Inside the machine Page 7.1

Note
The symbol * denotes an optional feature depending on 
machines.

Caution
To avoid tearing the paper, pull the jammed paper out gently 
and slowly. Follow the instructions in the following sections to 
clear the jam. 

In the paper feed area 
If paper is jammed in the paper feed area, follow the next steps to release 
the jammed paper. 

1 Using the handle, completely open the front cover. 

2 Carefully remove the paper by pulling in the direction as shown 
below. Go to step 7.

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling, and go to step 3.
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Caution
• Do not touch the green surface, the OPC drum or the front of 

each toner cartridge, with your hands or any other material. 
Use the handle on each cartridge in order to avoid touching 
this area.

• Be careful not to scratch the surface of the paper transfer 
belt.

• If you leave the front cover open for more than a few minutes, 
the OPC drum can be exposed to light. This will cause 
damage to the OPC drum. Close the front cover should the 
installation need to be halted for any reason.

3 Close the front cover.

4 Pull the tray open. 

5 Remove the jammed paper by gently pulling it straight out as shown 
below.

6 To replace the tray, lower the rear edge, align it with the slot, and 
slide it into the machine. 

7 Open the front cover and close it. The machine will resume printing.
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In the multi-purpose tray
When you print using the multi-purpose tray and the machine detects that 
there is either no paper or that the paper has been improperly loaded, 
follow the next steps to release the jammed paper.

1 Check if the paper is stuck in the feeding area, and if so, pull it out 
gently and slowly.

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling and go to step 2.

2 Close the multi-purpose tray.

3 Pull the tray1 out.

4 Open the inner cover while you are releasing the inner cover locks 
on each side of tray1 with two hands.

5 Pull the paper out gently.

6 Close the inner cover.

7 Replace the tray.

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling and go to step 8.

8 Using the handle, completely open the front cover.
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9 Remove the jammed paper by pulling in the direction shown. To 
avoid tearing the paper, pull it out gently and slowly.

Caution
• Do not touch the green surface, the OPC drum or the front of 

each toner cartridge, with your hands or any other material. 
Use the handle on each cartridge in order to avoid touching 
this area.

• Be careful not to scratch the surface of the paper transfer 
belt.

• If you leave the front cover open for more than a few minutes, 
the OPC drum can be exposed to light. This will cause 
damage to the OPC drum. Close the front cover should the 
installation need to be halted for any reason.

10 Close the front cover firmly. The machine will resume printing.

Caution
If the front cover is not completely closed, the machine will not 
operate.

In the fuser unit area
If paper is jammed in the fuser unit area, follow the next steps to release 
the jammed paper.

1 Open the top cover.

2 Open the inner cover using the handle on it. 

Caution
Do not touch the fuser inside the inner cover. It is hot and could 
cause burns! The fuser's operating temperature is 180°C 
(356°F). Take care when removing paper from the machine.
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3 Pull up the paper jam lever to release the fusing part of the fuser unit 
and carefully take the jammed paper out of the machine.

4 Press down the paper jam lever to fasten the fusing part.

5 Close the inner cover.

6 After removing the jammed paper, check for paper which may be 
jammed in other parts of the machine.

7 Close the top cover. Make sure that it is securely latched.

Caution
If the top cover is not completely closed, the machine will not 
operate.

In the paper exit area
If paper is jammed in the paper exit area, follow the next steps to release 
the jammed paper.

1 If a long portion of the paper is visible, pull it straight out. 
Open and close the front cover firmly. The machine will resume 
printing.

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling and go to step 2.

2 Open the top cover.

3 Open the inner cover using the handle on it. 

Caution
Do not touch the fuser inside the inner cover. It is hot and could 
cause burns! The fuser's operating temperature is 180°C 
(356°F). Take care when removing paper from the machine.

4 Pull up the paper jam lever to loose the fusing part of the fuser unit 
and carefully take the jammed paper out of the machine.
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5 Press down the paper jam lever to fasten the fusing part.

6 Close the inner cover.

7 After removing the jammed paper, check for paper which may be 
jammed in other parts of the machine.

8 Close the top cover. Make sure that it is securely latched.

Caution
If the top cover is not completely closed, the machine will not 
operate.

In the optional tray
If paper is jammed in the optional tray, follow the next steps to release the 
jammed paper.

1 Pull the optional tray open. After you pull it all the way out, lift up the 
front part of the tray slightly to release the tray from the machine.

2 If you see the jammed paper, remove the paper from the machine 
by gently pulling it straight out as shown below.

3 Slide the tray back into the machine and close the two jam covers. 

4 Open the front cover. 
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5 Pull the jammed paper out in the direction shown. To avoid tearing 
the paper, pull it out gently and slowly.

6 Close the front cover firmly. The machine will resume printing.

Caution
If the front cover is not completely closed, the machine will not 
operate.

Understanding display messages
Messages appear on the Smart Panel program window or on the control 
panel display to indicate machine status or errors. Refer to the tables 
below to understand the messages meaning to correct the problem, if 
necessary. Messages and their explanations are listed in alphabetical 
order.

Note
• When you call for service, it is very convenient to provide the 
service representative with the contents of the display message.
• If the message is not in the table, cycle the power and try the 
printing job again. If the problem persists, call for service. 
• Some messages may not appear in the display depending on 
options or models. If so, it is not applicable to your machine.

* xxx indicates the media type.
* yyy indicates the tray.

Message Explanation Solution

[yyy]
Cassette Out

The tray cassette is 
not inserted, or not 
properly closed.

To close the tray, 
lower the rear edge, 
align it with the slot, 
and slide it into the 
printer.

[yyy]
Paper Empty

There is no paper in 
the tray.

Load paper in the 
tray. (Page 4.4)

ADC Not
Confirm Error

There is a problem 
in the ADC (Analog 
to Digital Converter) 
of your machine.

Cycle power. If the 
problem persists, 
contact the service 
representatives.

ADC Slope Error
Cycle Power

The temperature 
slope for ADC 
(Analog to Digital 
Converter) detects 
the value out of the 
normal range.

Cycle power. If the 
problem persists, 
contact the service 
representatives.

Adjusting...
Registration

The machine is 
adjusting the color 
registration.

Wait a few minutes.

Deve Motor
Locked

There is a problem 
with the 
development motor 
to machines which 
moves the toner 
supply device.

Cycle power. If the 
problem persists, 
contact the service 
representatives.

Door Open/Check 
Transfer Belt

The front cover or 
the top cover is not 
securely latched.

Close the cover until it 
locks into place.
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Duplex Jam 0
Check Inside

Paper has jammed 
during duplex 
printing. This is 
applicable only to 
machines with this 
feature. 

Clear the jam. 
(Page 7.1)

Fuser Fan 
Locked

There is a problem 
with the fan for the 
fuser unit.

Cycle power. If the 
problem persists, 
contact the service 
representatives.

Install 
Transfer Belt

The transfer belt is 
not installed.

Install a Samsung-
genuine transfer belt. 
(Page 8.1, Page 6.6)

Install Toner The toner cartridge 
is installed 
improperly, or not 
installed.

Reinstall the toner 
cartridge two or three 
times to confirm it is 
seated properly. If the 
problem persists, the 
toner cartridge is not 
being detected. 
Contact the service 
representatives.

Invalid Toner The toner cartridge 
which the arrow 
indicates is not 
suitable for your 
machine.

Install the 
corresponding toner 
cartridge with a 
Samsung-genuine 
cartridge. (Page 6.4)

Invalid Transfer 
Belt

The transfer belt is 
not suitable for your 
machine.

Reinstall the transfer 
belt two or three times 
to confirm it is seated 
properly. Make sure 
that the transfer belt 
is Samsung-genuine 
product. If the 
problem persists, 
contact the service 
representatives.

IP Conflict The network IP 
address you have 
set is being used by 
someone else.

Check the IP address 
and reset it if 
necessary. (Page 3.2)

Load Manually
Press Stop Key

The multi-purpose 
tray is empty in 
manual feed mode.

Load paper in the 
multi-purpose tray. 
(Page 4.6)

Load
[xxx] In [yyy]

There is no 
corresponding paper 
in the corresponding 
tray.

Load corresponding 
paper in the 
corresponding tray. 
(Page 4.4)

Message Explanation Solution

Low Heat Error
Cycle Power

The fuser unit is low-
heated.

Cycle power. If the 
problem persists, 
contact the service 
representatives.

OPC Motor 
Locked

There is a problem 
with the main motor 
for the machine.

Cycle power. If the 
problem persists, 
contact the service 
representatives.

MP Tray 
Paper Jam 0

Paper has jammed 
in the multi-purpose 
tray.

Clear the jam. 
(Page 7.3)

New Fuser
Error

The problem has 
occurred in the 
newly installed fuser 
unit.

Cycle power. If the 
problem persists, 
contact the service 
representatives.

Non SAMSUNG 
Toner

The toner cartridge 
which the arrow 
indicates is not a 
Samsung-genuine 
cartridge.

  Stop  

You can select either 
Stop or Continue 
with the left/right 
arrow.
If you select Stop by 
pressing OK on the 
control panel, the 
machine stops 
printing. If you select 
Continue, the 
machine keeps 
printing, but the 
quality cannot be 
guaranteed. 
If you do not select 
any, the machine will 
work as if Stop is 
selected. 
Replace the 
corresponding toner 
cartridge with a 
Samsung-genuine 
cartridge. (Page 6.4)

Paper Jam 0
Open/Close Door

Paper has jammed 
in the paper feed 
area and inside the 
machine.

Clear the jam. 
(Page 7.1)

Paper Jam 1
Open/Close Door

Paper has jammed 
inside the machine.

Clear the jam. 
(Page 7.1)

Paper Jam 2
Check Inside

Special print media 
has jammed in the 
paper exit area.

Clear the jam. 
(Page 7.5)

Message Explanation Solution
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Replace Fuser The life of the fuser 
unit is expired.

Replace the fuser unit 
with a new one. 
Contact the service 
representatives.

Replace Fuser 
Soon

The life of the fuser 
unit will be expired 
soon.

Replace the fuser unit 
with a new one. 
Contact the service 
representatives.

Replace Transfer 
Belt

The life of the 
transfer belt is 
expired.

Replace the paper 
transfer belt with a 
new one. Contact the 
service 
representatives.

Replace Transfer 
Belt Soon

The life of the 
transfer belt will be 
expired soon.

Replace the transfer 
belt with a new one. 
Contact the service 
representatives.

Replace [yyy]
Pick-Roller

The life of the tray 
pick-up roller has 
expired.

Replace the pick-up 
roller with a new one. 
Contact the service 
representatives.

Self Diagnostics 
LSU

The LSU (Laser 
Scanning Unit) in 
your machine is 
checking problems 
detected. 

Wait a few minutes.

Self Diagnostics 
Temperature

The engine in your 
machine is checking 
problems detected. 

Wait a few minutes.

Sleeping... The machine is in 
the power save 
mode.

When data is 
received, it switches 
to on-line 
automatically.

System Fan 
Locked

There is a problem 
with the main fan for 
the machine.

Cycle power. If the 
problem persists, 
contact the service 
representatives.

Message Explanation Solution

Toner Empty The toner cartridge 
which the arrow 
indicates has run 
out.

  Stop  

Note
If the black toner 
cartridge is empty, 
Black Only 
message does not 
appear. 

You can select the 
option among Stop, 
Continue or Black 
Only with the left/right 
arrow. If you select 
Stop by pressing OK 
on the control panel, 
the machine stops 
printing. If you select 
Continue, the 
machine keeps 
printing, but the 
quality cannot be 
guaranteed. If you 
select Black Only, 
the machine prints 
the data in black. In 
this case, the mono 
printing feature is 
preset in the printer 
properties. 
If you do not select 
any, the machine will 
work as Stop is 
selected. Replace the 
corresponding toner 
cartridge with a 
Samsung-genuine 
cartridge. (Page 6.4) 

Toner Exhausted The lifespan of the 
toner cartridge 
which the arrow 
indicates is reached.

This message 
appears when the 
toner is completely 
empty, and your 
machine stops 
printing. Replace the 
corresponding toner 
cartridge with a 
Samsung-genuine 
cartridge. (Page 6.4)

Toner Low The toner cartridge 
which the arrow 
indicates is almost 
empty.

Take out the 
corresponding toner 
cartridge and 
thoroughly shake it. 
By doing this, you can 
temporarily 
reestablish printing 
operations. 
(Page 6.3)

Tray 2 
Paper Jam 0

Paper has jammed 
in the optional tray.

Clear the jam. 
(Page 7.6)

Message Explanation Solution
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Solving other problems
The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the 
problem is corrected. If the problem persists, call for service.

Paper feeding problems
Condition Suggested solutions

Paper is jammed 
during printing.

Clear the paper jam. (See "Clearing paper 
jams" on page 7.1.)

Paper sticks 
together.

• Ensure there is not too much paper in the tray. 
The tray can hold up to 250 sheets of paper, 
depending on the thickness of the paper.

• Make sure that you are using the correct type 
of paper. (See "Specifications on print 
media" on page 4.2.)

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together.

Multiple sheets of 
paper do not 
feed.

• Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

• If multiple sheets have caused a paper jam, 
clear the paper jam. (See "Clearing paper 
jams" on page 7.1.)

Paper does not 
feed into the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine. (See "Specifications on print 
media" on page 4.2.)

• Remove any obstructions from inside the 
machine.

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the multi-purpose 
tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine. (See "Specifications 
on print media" on page 4.2.)

• There may be debris inside the machine. 
Open the front cover and remove the debris.

Envelopes skew 
or fail to feed 
correctly.

Ensure the paper guides are against both sides 
of the envelopes.

Printing problems

Condition Possible cause Suggested solutions

The 
machine 
does not 
print.

The machine is not 
receiving power.

Check the power cord 
connections. Check the 
power switch and the power 
source.

The machine is not 
selected as the 
default printer.

Select a machine name as 
your default printer in your 
Windows.

Check the machine for the following:
• The cover is not closed. Close the cover.
• Paper is jammed. Clear the paper jam. (See 

"Clearing paper jams" on page 7.1.)
• No paper is loaded. Load paper. (See "Loading 

paper" on page 4.4.)
• The toner cartridge is not installed. Install the toner 

cartridge.
If a system error occurs, contact your service 
representative.

The connection cable 
between the 
computer and the 
machine is not 
connected properly.

Disconnect the printer cable 
and reconnect it.

The connection cable 
between the 
computer and the 
machine is defective.

If possible, attach the cable 
to another computer that is 
working properly and print a 
job. You can also try using a 
different printer cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has 
more than one port, make 
sure that the machine is 
attached to the correct one.

The machine may be 
configured 
incorrectly. 

Check the printer properties 
to ensure that all of the print 
settings are correct. 

The printer driver 
may be incorrectly 
installed.

Repair the printer software. 
See Software section.

The machine is 
malfunctioning.

Check the display message 
on the control panel to see if 
the machine is indicating a 
system error. Contact a 
service representative.
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The print 
quality is 
not good or 
not clear.

The environment is in 
the low temperature 
and low humidity. 
This envionment can 
cause the unclear 
print quality.

Go to printer properties, and 
change the printer language 
in Printer tab.

The black 
color of the 
print-out is 
not vivid 
black or 
fades. 

When the black toner 
cartridge is empty, 
the machine makes 
the black color 
compounded from 
the rest three color 
toner cartridges. This 
black-like color may 
not be exactly the 
same as the true 
black. Also, if the rest 
three color toner 
cartridges are getting 
empty, the color may 
fade.

Replace the black toner 
cartridge.

The 
machine 
selects print 
materials 
from the 
wrong 
paper 
source.

The paper option that 
was selected in the 
machine properties 
may be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Paper tab within 
the printer properties. Select 
the correct paper source. 
See the printer driver help 
screen.

A print job 
is extremely 
slow.

The job may be very 
complex.

Reduce the complexity of the 
page or try adjusting the print 
quality settings such as 
adjusting the resolution.

Half the 
page is 
blank.

The page orientation 
setting may be 
incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure the paper size in the 
printer driver settings 
matches the paper in the 
tray.
Or, ensure the paper size in 
the printer driver settings 
matches the paper selection 
in the software application 
settings you use.

Condition Possible cause Suggested solutions

The 
machine 
prints, but 
the text is 
wrong, 
garbled, or 
incomplete.

The printer cable is 
loose or defective.

Disconnect the printer cable 
and reconnect. Try a print job 
that you have already printed 
successfully. If possible, 
attach the cable and the 
machine to another computer 
and try a print job that you 
know works. Finally, try a 
new printer cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating system 
is malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine 
off and then back on again.

If you are under the 
DOS environment, 
the font setting for 
your machine may be 
set incorrectly. 

Change the font setting. See 
3.5

Pages print, 
but they are 
blank.

The toner cartridge is 
defective or out of 
toner.

Redistribute the toner, if 
necessary. 
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such as 
the controller or the 
board, may be 
defective.

Contact a service 
representative.

PDF file 
does not 
print 
correctly-
some parts 
are missing 
in the 
graphics, 
text or 
illustrations.

Incompatibility 
between the PDF file 
and the Acrobat 
products.

Printing the PDF file as an 
image may enable the file to 
print. Turn on Print As Image 
from the Acrobat printing 
options.
Note: It will take longer to 
print when you print a PDF 
file as an image.

Condition Possible cause Suggested solutions
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The print 
quality of 
photos is 
not good. 
Images are 
not clear.

The resolution is set 
to Normal. 

Change the resolution to 
Best in the machine 
properties window and then 
try printing again. 

The resolution of the 
photo is very low. 

Reduce the photo size. If you 
increase the photo size in the 
software application, the 
resolution will be reduced. 

Your 
machine 
has an odd 
smell 
during initial 
use.

The oil used to 
protect the fuser is 
evaporating.

After printing about 100 color 
pages, there will be no more 
smell. It is a temporary issue.

Before 
printing, the 
machine 
emits vapor 
near the 
output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

Condition Possible cause Suggested solutions Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
you may notice a reduction in print quality. See the table below to clear 
the problem. 

Condition Suggested solutions

Light or faded print If a vertical white streak or faded area appears 
on the page:
• The toner supply is low. You may be able to 

temporarily extend the toner cartridge life. If 
this does not improve the print quality, install 
a new toner cartridge.

• The paper may not meet paper 
specifications; for example, the paper may 
be too moist or rough. (See "Specifications 
on print media" on page 4.2.)

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is 
on. Adjust the print resolution and turn the 
toner save mode off. See the help screen of 
the printer driver and refer to Software 
section, respectively.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning. Contact a service representative.

• The surface of the LSU part inside the 
machine may be dirty. Clean the LSU, 
contact a service representative. 

Toner specks • The paper may not meet specifications; for 
example, the paper may be too moist or 
rough. (See "Specifications on print 
media" on page 4.2.)

• The paper transfer belt may be dirty. Clean 
the inside of your machine. Contact a 
service representative.

• The paper path may need cleaning. Contact 
a service representative.

Dropouts If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper. (See 
"Specifications on print media" on page 4.2.)

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• If these steps do not correct the problem, 
contact a service representative.
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White Spots White spots appear on the page:
• The paper is too rough and a lot of dirt from 

the paper falls to the inner devices within 
the machine, which means the transfer belt 
may be dirty. Clean the inside of your 
machine. Contact a service representative.

• The paper path may need cleaning. Contact 
a service representative.

Vertical lines If black vertical streaks appear on the page:
• The toner cartridge has probably been 

scratched. Remove the toner cartridge and 
install a new one.

If white vertical streaks appear on the page:
• Clean the inside of the machine. Contact a 

service representative to clean the inside of 
the machine.

Color or Black 
background

If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper. (See 

"Specifications on print media" on page 4.2.)
• Check the environmental conditions: very 

dry conditions (low humidity) or a high level 
of humidity (higher than 80% RH) can 
increase the amount of background 
shading.

• Remove the old toner cartridge, and then 
install a new one. (See "Replacing the toner 
cartridge" on page 6.4.)

Toner smear • Clean the inside of the machine. Contact a 
service representative to clean the inside of 
the machine.

• Check the paper type and quality. (See 
"Specifications on print media" on page 4.2.)

• Remove the paper transfer belt, and then 
install a new one. (See "Replacing the toner 
cartridge" on page 6.4.)

Condition Suggested solutions

Vertical repetitive 
defects

If marks repeatedly appear on the printed side 
of the page at even intervals:
• Clean the inside of the machine. Contact a 

service representative to clean the inside of 
the machine. After cleaning the inside of the 
machine, if you still have the same 
problems, install a new toner cartridge of the 
problem color. See "Replacing the toner 
cartridge" on page 6.4.

• Parts of the machine may have toner on 
them. If the defects occur on the back of the 
page, the problem will likely correct itself 
after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Background scatter Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a different batch of paper. Do not open 
packages of paper until necessary so that 
the paper does not absorb too much 
moisture.

• If background scatter occurs on an 
envelope, change the printing layout to 
avoid printing over areas that have 
overlapping seams on the reverse side. 
Printing on seams can cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print resolution through your software 
application or in printer properties.

Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock 
may be too slick. Try different paper. (See 
"Specifications on print media" on page 4.2.)

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. (See 

"Specifications on print media" on page 4.2.)
• Ensure that the paper or other material is 

loaded correctly and the guides are not too 
tight or too loose against the paper stack.

Condition Suggested solutions
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Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl. (See "Specifications on print media" on 
page 4.2.)

• Turn the stack of paper over in the tray. Also 
try rotating the paper 180° in the tray.

Wrinkles or creases • Ensure that the paper is loaded properly.
• Check the paper type and quality. (See 

"Specifications on print media" on page 4.2.)
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray.

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of 
the machine. Contact a service 
representative.

Black pages • The toner cartridge may not be installed 
properly. Remove the cartridge and reinsert 
it.

• The toner cartridge may be defective and 
need replacing. Remove the toner cartridge 
and install a new one. (See "Replacing the 
toner cartridge" on page 6.4.)

• The machine may require repair. Contact a 
service representative.

Condition Suggested solutions

Loose toner • Clean the inside of the machine. Contact a 
service representative to clean the inside of 
the machine. After cleaning the inside of the 
machine, if you still have the same 
problems, contact a service representative.

• Check the paper type and quality. (See 
"Specifications on print media" on page 4.2.)

• Remove the toner cartridge, and then install 
a new one. (See "Replacing the toner 
cartridge" on page 6.4.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Character Voids Character voids are white areas within parts of 
characters that should be solid black:
• You may be printing on the wrong surface of 

the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper 
specifications. (See "Specifications on print 
media" on page 4.2.)

Horizontal stripes If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a 
new one. (See "Replacing the toner 
cartridge" on page 6.4.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray. 

Condition Suggested solutions
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Common Windows problems

Note
Refer to Microsoft Windows 2000/XP/2003/Vista User’s Guide 
that came with your PC for further information on Windows error 
messages.

An unknown image 
repetitively appears 
on the next few 
sheets or loose 
toner, light print, or 
contamination 
occurs. 

You machine is probably being used at an 
altitude of 1,000 m (3,281 ft) or above. The 
high altitude may affect the print quality from 
loose toner or light imaging. You can set this 
option through Printer Settings Utility or the 
Printer Tab in printer driver’s properties. See 
"Altitude Setting after Software Installation" on 
page 3.4.

Condition Suggested solutions

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the StartUp Group, then restart 
Windows. Reinstall the printer driver.

“Error Writing to 
LPTx” message 
appears.

• Ensure that the cables are connected 
correctly and the machine is on.

• If bi-directional communication is not turned 
on in the driver, it will also cause this 
message.

“General 
Protection Fault”, 
“Exception OE”, 
“Spool32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
machine timeout 
error occurred.” 
messages appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in standby 
mode or after printing has been completed, 
check the connection and/or whether an error 
has occurred.

Condition Suggested solutions Common PostScript problems
The following situations are PS language specific and may occur when 
several printer languages are being used.

Note
To receive a printed or screen-displayed message when 
PostScript errors occur, open the Print Options window and click 
the desired selection next to the PostScript errors section.

Problem Possible Cause Solution

PostScript file 
cannot be 
printed.

The PostScript 
driver may not be 
installed correctly.

• Install the PostScript 
driver, referring to Software 
section.

• Print a configuration page 
and verify that the PS 
version is available for 
printing.

• If the problem persists, 
contact a service 
representative.

“Limit Check 
Error” message 
appears.

The print job was 
too complex.

You might need to reduce 
the complexity of the page or 
install more memory.

A PostScript 
error page 
prints.

The print job may 
not be PostScript.

Make sure that the print job 
is a PostScript job. Check to 
see whether the software 
application expected a setup 
or PostScript header file to 
be sent to the machine.

The optional 
tray is not 
selected in the 
driver.

The printer driver 
has not been 
configured to 
recognize the 
optional tray.

Open the PostScript driver 
properties, select the Device 
Settings tab, and set the 
Tray option of the Installable 
Options section to Installed.

When printing 
a document in 
Macintosh with 
Acrobat 
Reader 6.0 or 
higher, colors 
print 
incorrectly.

The resolution 
setting in the 
printer driver may 
not be matched 
with the one in 
Acrobat Reader.

Make sure that the resolution 
setting in your printer driver 
matches the one in Acrobat 
Reader.
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Common Linux problems

Problem Possible Cause and Solution

The machine does not 
print.

• Check if the printer driver is installed in 
your system. Open the Unified Driver 
configuration tool and switch to the 
Printers tab in the Printers configuration 
window to look at the list of available 
machines. Make sure that your machine 
is displayed on the list. If not, use the 
Add new printer wizard to set up your 
device.

• Check if the machine has started. Open 
Printers configuration and select your 
machine on the machines list. Look at 
the description in the Selected printer 
pane. If its status contains a “(stopped)” 
string, click Start. After that, normal 
operation of the machine should be 
restored. The “stopped” status might 
have been activated when problems in 
printing occurred. 

• Check if your application has special 
print options such as “-oraw”. If “-oraw” 
is specified in the command line 
parameter, then remove it to print 
properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit the 
command line parameter in the 
command item.

• The CUPS (Common Unix Printing 
System) version distributed with SuSE 
Linux 9.2 (cups-1.1.21) has a problem 
with ipp (Internet Printing Protocol) 
printing. Use the socket printing instead 
of ipp or install a later version of CUPS 
(cups-1.1.22 or higher).

Some color images 
come out in 
unexpected color.

This is a known bug in Ghostscript (until 
GNU Ghostscript version 7.xx) when the 
base color space of the document is 
indexed RGB color space and it is 
converted through CIE color space. 
Because Postscript uses CIE color space 
for Color Matching System, you should 
upgrade Ghostscript on your system to at 
least GNU Ghostscript version 8.xx or 
later. You can find recent Ghostscript 
versions at www.ghostscript.com.

Common Macintosh problems

The machine does not 
print whole pages and 
its output is half-page 
printed. 

It is a known problem that occurs when a 
color machine is used on version 8.51 or 
earlier of Ghostscript, 64-bit Linux OS, and 
reported to bugs.ghostscript.com as 
Ghostscript Bug 688252. The problem is 
solved in AFPL Ghostscript v. 8.52 or 
above. Download the latest version of 
AFPL Ghostscript from http://
sourceforge.net/projects/ghostscript/ and 
install it to solve this problem.

I encounter error 
“Cannot open port 
device file” when 
printing a document.

Avoid changing print job parameters (via 
LPR GUI, for example) while a print job is 
in progress. Known versions of CUPS 
server cut off the print jobs whenever print 
options are changed and then try to restart 
the job from the beginning. Since Unified 
Linux Driver locks the port while printing, 
the abrupt termination of the driver keeps 
the port locked and therefore unavailable 
for subsequent print jobs. If this situation 
occurs, try to release the port. 

Problem Suggested solutions

PDF file does not print 
correctly-some parts are 
missing in the graphics, 
text or illustrations.

Incompatibility between the PDF file and 
the Acrobat products.
Printing the PDF file as an image may 
enable the file to print. Turn on Print As 
Image from the Acrobat printing options.
Note: It will take longer to print when 
you print a PDF file as an image.

The document has 
printed, but the print job 
has not disappeared from 
the spooler in 
Mac OS 10.3.2.

Update your Mac OS to OS 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the cover page 
printing.

This problem is caused because the 
Mac OS cannot find the font during the 
cover page printing. English alphabet 
and numbers are displayed normally on 
the cover page.

Some fonts are not 
printed properly in the 
Adobe Illustrator 
program.

Those fonts may not supported by your 
machine. Start the Adobe Illustrator 
program, click File > Print > Illustrator 
tab. Then, check Force Fonts to 
Download, and try again.

Problem Possible Cause and Solution
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8 Ordering supplies and 
accessories

This chapter provides information on purchasing cartridges and 
accessories available for your machine.

This chapter includes:
• Supplies
• Accessories
• How to purchase

Supplies
When the toner runs out, you can order the following type of toner 
cartridge for your machine:

Caution
When you purchase a new toner cartridge or supplies, you must 
purchase them in the same country you have purchased your 
machine. Otherwise, the toner cartridge or supplies will be 
incompatible with your machine since the configuration of the 
toner cartridge or supplies vary depending on the countries.

Type Average yielda

a. Declared yield value in accordance with ISO/IEC 19798.

Part number

High yield 
toner cartridge

Approx. 
5,500 (Black), 
5,000 (Color)

CLP-K660B (Black)
CLP-C660B (Cyan)
CLP-M660B (Magenta)
CLP-Y660B (Yellow)

Standard yield 
toner cartridge

Approx. 
2,500 (Black), 
2,000 (Color)

CLP-K660A (Black)
CLP-C660A (Cyan)
CLP-M660A (Magenta)
CLP-Y660A (Yellow)

Paper transfer 
belt

When the transfer 
belt has worn out 
with abrasion, you 
need to change it. 
By this time you 
may be notified with 
the transfer belt-
related message on 
the display.

CLP-T660B

Accessories
You can purchase and install accessories to enhance your machine’s 
performance and capacity.

Note
Your machine may have two memory slots with a factory pre-
installed memory module in one slot. When you are expanding 
the memory capacity, you can add a memory module to the 
vacant memory slot, according to the table above. It is strongly 
recommended that you expand a memory module in vacant 
memory slot only, without removing a pre-installed memory 
module. If your machine has 128MB memory capacity and you 
want to add 512MB, the memory capacity expands up to 
640MB.

How to purchase
To order Samsung-authorized supplies or accessories, contact your local 
Samsung dealer or the retailer where you purchased your machine, or 
visit www.samsungprinter.com and select your country/region to obtain 
information on calling for technical support.

Accessory Description Part number

Memory 
module

Extends your machine’s 
memory capacity.

• CLP-660 series
CLP-MEM101: 128 MB
CLP-MEM102: 256 MB
CLP-MEM103: 512 MB 

• CLP-610 series
CLP-MEM201: 128 MB
CLP-MEM202: 256 MB

Optional 
tray 2

If you are experiencing 
frequent paper supply 
problems, you can 
attach an additional 500 
sheet tray. You can print 
documents in various 
sizes and types of print 
materials.

CLP-S660A

Duplex unit Enables duplex printing 
to save the paper 
consumption.

CLP-U660A
Note: If you want to use 
the duplex feature, contact 
the sales point to 
purchase the duplex 
option.

http://www.samsungprinter.com
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9 Installing accessories
Your machine is a full-featured model that has been optimized to meet 
most of your printing needs. Recognizing that each user may have 
different requirements, however, Samsung makes several accessories 
available to enhance your machine’s capabilities.

This chapter includes:
• Precautions to take when installing accessories
• Installing a memory module

Precautions to take when installing accessories

• Disconnect the power cord

Never remove the control board cover while the power is turned on.

To avoid the possibility of an electrical shock, always disconnect the 
power cord when installing or removing ANY internal or external 
accessories.

• Discharge static electricity

The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

Installing a memory module
Your machine has a dual in-line memory module (DIMM). Use this 
memory module slot to install additional memory.

The machine has two memory slots with a factory pre-installed memory 
module in one slot. When you are expanding the memory capacity, you 
can add a memory module to the vacant memory slot. It is strongly 
recommended that you expand a memory module in vacant memory slot 
only without removing the pre-installed memory module. If your machine 
has 128 MB memory capacity and you want to add 512 MB, the memory 
capacity expands up to 640 MB.

Order information is provided for optional memory module. (See 
"Accessories" on page 8.1.)

1 Turn the machine off and unplug all cables from the machine.

2 Open the control board cover. Release the screw, then lift up the 
cover slightly and pull the cover to the right.

Note
If you want to remove an existing memory module, push the 
two latches at the ends of the module outward.

3 Take out a new memory module from the plastic bag.

4 Holding the memory module by the edges, align the memory 
module on the slot at about a 30-degree tilt. Make sure that the 
notches of the module and the grooves on the slot fit each other.

Note
The notches and grooves illustrated above may not match 
those on an actual memory module and its slot.

5 Press the memory module into the slot with care until you hear a 
'click'. 

Caution 
Do not press the memory module strongly or the module 
may be damaged. If the module does not seem to fit into 
the slot properly, carefully try the previous procedure again.

1 control board cover
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6 Replace the control board cover and fasten the cover with the 
screw.

7 Reconnect the power cord and printer cable, and turn the machine 
on.

Note
To release the memory module, pull the two tabs on the 
sides of the slot outwards, then the module springs out. 

Activating the added memory in the PS printer 
properties
After installing the memory module, you need to select it in the printer 
properties of the PostScript printer driver in order to use it. This activation 
is needed only the machine compatible with the PostScript driver.

1 Make sure that the PostScript printer driver is installed on your 
computer. For details about installing the PS printer driver, see 
Software section.

2 Click the Windows Start menu.

3 For Windows 2000, select Settings and then Printers.

For Windows XP/2003, select Printers and Faxes.

For Windows Vista, select Control Panel > Hardware and Sound 
> Printers.

4 Select the Samsung CLP-6xx Series PS printer.

5 Click the right mouse button on the printer icon and select 
Properties.

6 Select Device Settings.

7 Select the amount of memory you installed from Printer Memory in 
the Installable Options section.

8 Click OK.
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10 Specifications
This chapter includes:
• CLP-610 Series
• CLP-660 Series

Note
The numbers herein is subject to change according to its install 
environment.

CLP-610 Series

Item Specifications and Description

Printing speeda Up to 20 ppmb (A4), 21 ppm (Letter)

Duplex printing 
speed

Up to 9.86 ipmc (A4, Letter)

Printing resolution Max. 2,400 x 600 dpi effective output

Warm-up time Less than 40 seconds

First print out time 20 seconds (from Ready mode)

Consumables life Standard yield 
toner cartridged

• Average continuous 
colored cartridge yield: 
Approx. 2,500 standard 
pages (Black)

• Average continuous 
colored cartridge yield: 
Approx. 2,000 standard 
pages (Yellow/Magenta/
Cyan)

High yield toner 
cartridged

• Average continuous 
colored cartridge yield: 
Approx. 5,500 standard 
pages (Black)

• Average continuous 
colored cartridge yield: 
Approx. 5,000 standard 
pages (Yellow/Magenta/
Cyan)

Paper transfer 
belt 

• 50,000 pages (Black, 
A4, Letter)

• 50,000 pages (Yellow/
Magenta/Cyan, A4, 
Letter)

Noise levele • Less than 29 dBA (from Ready mode)
• Less than 51 dBA (from Printing mode)

Power rating AC 110 - 127 V or AC 220 - 240 V
See the Rating label on the machine for the 
correct voltage, frequency (hertz) and type of 
current for your machine.

Power 
consumption

• Printing mode: less than 550 W
• Ready mode: less than 120 W
• Power save mode: less than 17 W

External dimension 
(W x D x H)

432 x 432 x 424 mm (17 x 17 x 16.7 inches)
(without optional tray)

Weight 25.6 Kg (56.44 lbs) 
(including consumables)

Package weight Paper 3.8 kg (8.38 lbs)

Plastic 1.1 kg (2.43 lbs)

Operating 
environment

Operating 
Temperature

10 to 32.5 °C (50 to 90 °F)

Recommended 
Temperature

15 to 30 °C (59 to 86 °F)

Operating 
Humidity

20 to 80% RH

Recommended 
Humidity

20 to 80% RH

Memory 128 MB (expandable up to 384 MB)
DDR2 only, 2 slots

Fonts SPL-C OS Fonts

PCL6 1 bitmap 45 scalable

Interface USB 2.0
Ethernet 10/100 Base TX

OS compatibility & 
driver

Windows 2000/ 
2003/ XP/ Vista

SPL-C (Samsung Printer 
Language Color) driver, 
PCL6 driver

Various Linux 
OS

SPL-C driver

Mac 10.3 ~ 10.5 SPL-C driver

Printer language PCL5c, PCL6, SPL-C

Option 500 sheet tray

Duty cycle Up to 65,000 pages (Monthly)

Fusing 
temperature

180 °C (356 °F)

Item Specifications and Description
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CLP-660 Series

Note
The symbol * denotes an optional feature depending on 
machines.   

a. Printing speed: it will be affected by operating system used, computing 
performance, application software, connecting method, media type, media size, 
and job complexity.

b. ppm: page per minute.
c. ipm: image per minute.
d. Declared yield value in accordance with ISO/IEC 19798.
e. Noise Level: sound pressure level, ISO 7779.

Item Specifications and Description

Printing speeda Up to 24 ppmb (A4), 25 ppm (Letter)

Duplex printing 
speed*

Up to 11.8 ipmc (A4, Letter)

Printing resolution Max. 2,400 x 600 dpi effective output

Warm-up time Less than 30 seconds

First print out time 14 seconds (from Ready mode)

Consumables life Standard yield 
toner cartridged

• Average continuous 
colored cartridge yield: 
Approx. 2,500 standard 
pages (Black)

• Average continuous 
colored cartridge yield: 
Approx. 2,000 standard 
pages (Yellow/Magenta/
Cyan)

High yield toner 
cartridge

• Average continuous 
colored cartridge yield: 
Approx. 5,500 standard 
pages (Black)

• Average continuous 
colored cartridge yield: 
Approx. 5,000 standard 
pages (Yellow/Magenta/
Cyan)

Paper transfer 
belt 

• 50,000 pages (Black, 
A4, Letter)

• 50,000 pages (Yellow/
Magenta/Cyan, A4, 
Letter)

Noise levele • Less than 29 dBA (from Ready mode)
• Less than 53 dBA (from Printing mode)

Power rating AC 110 - 127 V or AC 220 - 240 V
See the Rating label on the machine for the 
correct voltage, frequency (hertz) and type of 
current for your machine.

Power consumption • Printing mode: less than 700 W
• Ready mode: less than 120 W
• Power save mode: less than 17 W

External dimension 
(W x D x H)

432 x 432 x 424 mm (17 x 17 x 16.7 inches)
(without optional tray)

Weight 25.6 Kg (55.44 lbs) 
(including consumables)

Package weight Paper 3.8 kg (8.38 lbs)

Plastic 1.1 kg (2.43 lbs)

Operating 
environment

Operating 
Temperature

10 to 32.5 °C (50 to 90 °F)

Recommended 
Temperature

15 to 30 °C (59 to 86 °F)

Operating 
Humidity

20 to 80% RH

Recommended 
Humidity

20 to 80% RH

Memory 128 MB (expandable up to 640 MB)
DDR1 only, 2 slots

Fonts SPL-C OS Fonts

PCL6 1 bitmap 45 scalable

PS 136

Interface USB 2.0
Ethernet 10/100 Base TX

OS compatibility & 
driver

Windows 2000/ 
2003/ XP/ Vista

SPL-C, PCL6 driver, 
PostScript driver

Various Linux 
OS

PostScript driver

Mac 10.1 ~ 10.5 PostScript driver

Printer language PCL5c, PCL6, PostScript 3, SPL-C

Option 500 sheet tray

Duty cycle Up to 80,000 pages (Monthly)

Fusing temperature 180 °C (356 °F)

Item Specifications and Description
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a. Printing speed: it will be affected by operating system used, computing 
performance, application software, connecting method, media type, media 
size, and job complexity.

b. ppm: page per minute.
c. ipm: image per minute.
d. Declared yield value in accordance with ISO/IEC 19798.
e. Noise Level: sound pressure level, ISO 7779.
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11 Glossary
BOOTP
It stands for Bootstrap Protocol, a network protocol used by a network 
client to obtain its IP address automatically. This is usually done in the 
bootstrap process of computers or operating systems running on them. 
The BOOTP servers assign the IP address from a pool of addresses to 
each client. 

Control Panel
A control panel is a flat area where control or monitoring instruments are 
displayed. They are typically found in top or front of the machine. 

Coverage
This is the printing term used for toner usage measurement on printing 
and generally used as 5% coverage. 5% coverage means that an A4 
sized paper has about 5% image or text on it. So, if the paper or original 
has complicated images or lots of text on it, the coverage will be over 5% 
and at the same time, toner usage will be as much as the coverage.

Default
The first set values.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network.

DIMM
Dual Inline Memory Module, a small circuit board that holds memory. 
DIMM stores all the data within the machine like printing data, received 
fax data, or scanned data.

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks. 

DPI
This is the measurement of resolution which is used for printing or 
scanning. Generally, more dots per inch result in a higher resolution, 
more visible detail in the image, and a larger file size. 

Duplex
This is a mechanism which automatically flips over a sheet of paper so 
that the machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex can print double-sided. 

Duty Cycle
Duty cycle is the page quantity which does not affect printer performance 
for a month. Generally the printer has the lifespan limitation such as 
pages per year. The lifespan means the average capacity of print-outs, 
usually within the warranty period. For example, if the duty cycle is 48,000 
pages per month assuming 20 working days, a printer limits 2,400 pages 
a day, which is not small amount.

Ethernet
Ethernet is a frame-based computer networking technology for local area 
networks (LANs). It defines wiring and signaling for the physical layer, 
and frame formats and protocols for the media access control (MAC)/data 
link layer of the OSI model. It has become the most widespread LAN 
technology in use presently.

Fuser Unit 
This is the part of a laser printer that melts the toner onto the print media. 
It consists of two hot rollers. After toner is transferred onto the paper, the 
fuser unit applies heat and pressure to ensure that the toner stays on the 
paper permanently, which is why paper is warm when it comes out of a 
laser printer.

Gateway
This is a connection between computer networks, or between a computer 
network and a telephone line. And it is very popular, as it is a computer 
or a network that allows access to another computer or network.

Grayscale
Shades of gray that represent light and dark portions of an image when 
color images are converted to grayscale; colors are represented by 
various shades of gray.

Halftone
This is an image type that simulates grayscale by varying the number of 
dots. Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

Intranet
This is a private network that uses Internet Protocols, network 
connectivity, and possibly the public telecommunication system to 
securely share part of an organization's information or operations with its 
employees. Sometimes the term refers only to the most visible service, 
the internal website.

IP address
An Internet Protocol address (IP address) is a unique number that 
devices use in order to identify and communicate with each other on a 
network utilizing the Internet Protocol standard (IP).

IPM
The Images Per Minute.



11.2   <Glossary>

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

LED
A light-emitting diode (LED) is a semiconductor device that indicates the 
status of a machine. 

Print Media
Media such as papers, envelopes, labels, and transparencies which can 
be used on a printer, a scanner, a fax or, a copier. 

OPC Drum
A mechanism that makes a virtual image for print using a laser beam 
emitted from a laser printer, and it is usually green or gray-colored and 
cylinder-shaped. An exposing unit of a drum is slowly worn away by its 
usage of the printer, and it should be replaced appropriately since it  
becomes scratched from grit in paper.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two-dimensional documents in a 
device-independent and resolution-independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas, 
and that is run in an interpreter to generate an image.

PPM
Pages Per Minute. PPM shows the printer's speed, how many pages a 
printer can actually print per minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
This is a convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

Resolution
The sharpness of an image, measured in dots per inch (dpi). The higher 
the dpi, the greater the resolution.

Subnet Mask 
A bitmask used to tell how many bits in an octet(s) identify the 
subnetwork, and how many bits provide room for host addresses.  

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP). 
It is the set of communications protocols that implement the protocol 
stack on which the Internet and most commercial networks run.

toner cartridge
It is a kind of bottle within a machine like a printer which contains toner. 
Toner is a powder used in laser printers and photocopiers which forms the 
text and images on the printed paper. Toner can be melted by the heat of 
the fuser, causing it to bind to the fibers in the paper.

URL
Uniform Resource Locator (URL) is the global address of documents and 
resources on the Internet. The first part of the address indicates what 
protocol to use, the second part specifies the IP address or the domain 
name where the resource is located.

USB
Universal serial bus (USB) is a standard that was developed by the USB 
Implementers Forum, Inc., to connect computers and peripherals. Unlike 
the parallel port, USB is designed to concurrently connect a single 
computer USB port to multiple peripherals.
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1 Installing Printer 
Software in Windows
This chapter includes:

• Installing Printer Software

• Reinstalling Printer Software

• Removing Printer Software

• Installing mono printer driver

NOTE: The following procedure is based on Windows XP, for 
other operating systems, refer to the corresponding Windows 
user's guide or online help.

Installing Printer Software
You can install the printer software for local printing or network 
printing. To install the printer software on the computer, 
perform the appropriate installation procedure depending on 
the printer in use.

A printer driver is software that lets your computer 
communicate with your printer. The procedure to install drivers 
may differ depending on the operating system you are using.

All applications should be closed on your PC before beginning 
installation. 

Installing Software for Local Printing
A local printer is a printer directly attached to your computer 
using the printer cable supplied with your printer, such as a USB 
or parallel cable. If your printer is attached to a network, skip 
this step and go to “Installing Software for Network Printing” on 
page 7.

You can install the printer software using the typical or custom 
method.

NOTE: If the “New Hardware Wizard” window appears during 
the installation procedure, click  in the upper right corner of 
the box to close the window, or click Cancel.

Typical Installation

This is recommended for most users. All components necessary 
for printer operations will be installed.

1 Make sure that the printer is connected to your computer 
and powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.

4 Select Typical installation for a local printer. Click 
Next.
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NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The installation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

5 After the installation is finished, a window asking you to 
print a test page appears. If you choose to print a test 
page, select the checkbox and click Next.

Otherwise, just click Next and skip to step 7.

6 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

7 To register yourself as a user of Samsung Printers in order 
to receive information from Samsung, select the checkbox 
and click Finish. You are now sent to the Samsung web 
site.

Otherwise, just click Finish.

NOTE: After setup is complete, if your printer driver doesn’t 
work properly, reinstall the printer driver. See “Reinstalling 
Printer Software” on page 10.

Custom Installation

You can choose individual components to install.

1 Make sure that the printer is connected to your computer 
and powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.

• View User’s Guide: Allows you to view the User’s 
Guide. If your computer doesn’t have Adobe Acrobat, 
click on this option and it will automatically install Adobe 
Acrobat Reader for you.



Installing Printer Software in Windows
6

4 Select Custom installation. Click Next.

5 Select your printer and click Next.

NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The installation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

6 Select the components to be installed and click Next.

NOTE: You can change the desired installation folder by 
clicking [Browse].

7 After the installation is finished, a window asking you to 
print a test page appears. If you choose to print a test 
page, select the checkbox and click Next.

Otherwise, just click Next and skip to step 9.

8 If the test page prints out correctly, click Yes.

If not, click No to reprint it.
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9 To register yourself as a user of Samsung Printers in order 
to receive information from Samsung, select the checkbox 
and click Finish. You are now sent to the Samsung web 
site.

Otherwise, just click Finish.

Installing Software for Network 
Printing
When you connect your printer to a network, you must first 
configure the TCP/IP settings for the printer. After you have 
assigned and verified the TCP/IP settings, you are ready to 
install the software on each computer on the network.

You can install the printer software using the typical or custom 
method.

Typical Installation

This is recommended for most users. All components necessary 
for printer operations will be installed.

1 Make sure that the printer is connected to your network 
and powered on. For details about connecting to the 
network, see the supplied printer’s User’s Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.

• View User’s Guide: Allows you to view the User’s 
Guide. If your computer doesn’t have Adobe Acrobat, 
click on this option and it will automatically install Adobe 
Acrobat Reader for you.

4 Select Typical installation for a network printer. Click 
Next.
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5 The list of printers available on the network appears. 
Select the printer you want to install from the list and then 
click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your 
printer to the network. To add the printer to the 
network, enter the port name and the IP address for the 
printer.

To verify your printer’s IP address or the MAC address, 
print a Network Configuration page.

• To find a shared network printer (UNC Path), select 
Shared Printer [UNC] and enter the shared name 
manually or find a shared printer by clicking the Browse 
button.

NOTE:  If you cannot find your machine in network, please 
turn off the firewall and click Update.

6 After the installation is finished, a window appears asking 
you to print a test page and to register yourself as a user 
of Samsung Printers in order to receive information from 
Samsung. If you so desire, select the corresponding 
checkbox(es) and click Finish.

Otherwise, just click Finish.

NOTE: After setup is complete, if your printer driver doesn’t 
work properly, reinstall the printer driver. See “Reinstalling 
Printer Software” on page 10.

Custom Installation

You can choose individual components to install and set a 
specific IP address.

1 Make sure that the printer is connected to your network 
and powered on. For details about connecting to the 
network, see the supplied printer’s User’s Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.

• View User’s Guide: Allows you to view the User’s 
Guide. If your computer doesn’t have Adobe Acrobat, 
click on this option and it will automatically install Adobe 
Acrobat Reader for you.
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4 Select Custom installation. Click Next.

5 The list of printers available on the network appears. 
Select the printer you want to install from the list and then 
click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your 
printer to the network. To add the printer to the 
network, enter the port name and the IP address for the 
printer.

To verify your printer’s IP address or the MAC address, 
print a Network Configuration page.

• To find a shared network printer (UNC Path), select 
Shared Printer [UNC] and enter the shared name 
manually or find a shared printer by clicking the Browse 
button.

NOTE: If you cannot find your machine in network, please turn 
off the firewall and click Update. For Windows operating 
system, click Start ->Control Panel and start windows 
firewall, and set this option unactivated. For other operating 
system, refer to its on-line guide.

TIP: If you want to set a specific IP address on a specific 
network printer, click the Set IP Address button. The Set IP 
Address window appears. Do as follows:

a. Select a printer to be set with a specific IP address from the 
list.

b. Configure an IP address, subnet mask, and gateway for the 
printer manually and click Configure to set the specific IP 
address for the network printer.

c. Click Next.

6 Select the components to be installed. After selecting the 
components, the following window appears. You can also 
change the printer name, set the printer to be shared on 
the network, set the printer as the default printer, and 
change the port name of each printer. Click Next.

To install this software on a server, select the Setting up 
this printer on a server checkbox.
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7 After the installation is finished, a window appears asking 
you to print a test page and to register yourself as a user 
of Samsung Printers in order to receive information from 
Samsung. If you so desire, select the corresponding 
checkbox(es) and click Finish.

Otherwise, just click Finish.

NOTE: After setup is complete, if your printer driver doesn’t 
work properly, reinstall the printer driver. See “Reinstalling 
Printer Software” on page 10.

Reinstalling Printer Software
You can reinstall the software if installation fails.
1 Start Windows.

2 From the Start menu select Programs or All Programs → 
your printer driver name → Maintenance.

3 Select Repair and click Next.

4 The list of printers available on the network appears. 
Select the printer you want to install from the list and then 
click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your 
printer to the network. To add the printer to the 
network, enter the port name and the IP address for the 
printer.

• To find a shared network printer (UNC Path), select 
Shared Printer [UNC] and enter the shared name 
manually or find a shared printer by clicking the Browse 
button.

You will see a component list so that you can reinstall any 
item individually.
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NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The reinstallation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

5 Select the components you want to reinstall and click 
Next.

If you installed the printer software for local printing 
and you select your printer driver name, the window 
asking you to print a test page appears. Do as follows:

a. To print a test page, select the check box and click 
Next.

b. If the test page prints out correctly, click Yes.

If it doesn’t, click No to reprint it.
6 When the reinstallation is done, click Finish.

Removing Printer Software

1 Start Windows.

2 From the Start menu select Programs or All Programs → 
your printer driver name → Maintenance.

3 Select Remove and click Next.

You will see a component list so that you can remove any 
item individually.

4 Select the components you want to remove and then click 
Next.

5 When your computer asks you to confirm your selection, 
click Yes.

The selected driver and all of its components are removed 
from your computer.

6 After the software is removed, click Finish.
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Installing mono printer driver
This printer features a monochrome-only printer. This mono 
driver limits output to the black toner, so you can use your 
printer as a monochrome printer. You must install the mono 
driver on your computer. Following steps guide you through the 
step by step installation process.

1 Make sure that the printer is connected to your computer 
and powered on. Or your computer and printer are 
connected to the network.

2 Insert the supplied CD-ROM into your CD-ROM drive. The 
CD-ROM should automatically run, and an installation 
window appears.

3 Click Cancel. 

If the confirmation window appears, click Finish.

4 Click Start → Printers and Faxes.

5 Select Add Printer.

6 When Add Printer Wizard appears, click Next.

7 Select Local printer attached to this computer, and 
Automatically detect and install my Plug and Play 
printer, then click Next. Go to step 13.

If your computer does not find the printer, then follow the 
next step.

8 Select Next in the Select a Printer Port window.

9 In the Select a Printer Port window, select Have Disk....

10Click Browse to find a mono driver for your printer.

ex) Windows XP 32 bit

Select CD-ROM drive → Printer → PC_MONO → 
WINXP_2000_VISTA-32

11Select ***.inf file and click Open.

12Click OK in the Install From Disk window.

13Select a mono driver in the Printers field, and click Next.

NOTE: If you have installed a mono driver before, then the 
Use Existing Driver window. Select as the window explains, 
and click Next. Also, depending on your computer 
configuration, the printer sharing window or the print the test 
page window may appear; make the appropriate selection.

14Enter your printer name, and click Next.

15Click Finish to start installing a mono printer driver.

NOTE: If your printer is connected to a network, go to 
printer's Properties and select the Ports tab, then click Add 
Portand Standard TCP/IP Port, and create a new port to 
connect to the printer. To create a new port, follow the 
procedure laid out in the wizard window.
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2 Basic Printing 
This chapter explains the printing options and common printing 
tasks in Windows. 

This chapter includes:

• Printing a Document

• Printing to a file (PRN)

• Printer Settings

- Layout Tab

- Paper Tab

- Graphics Tab

- Extras Tab

- About Tab

- Printer Tab

- Using a Favorite Setting

- Using Help

Printing a Document

NOTES: 
• Your printer driver Properties window that appears in this 

User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• When you select an option in printer properties, you may see 
an exclamation (!) mark or X mark. An exclamation mark 
means you can select that certain option but it is not 
recommended, and X mark means you cannot select that 
option due to the machine’s setting or environment.

• Check the Operating System(s) that are compatible 
with your printer. Please refer to the OS Compatibility 
section of Printer Specifications in your Printer User’s 
Guide.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

The following procedure describes the general steps required 
for printing from various Windows applications. The exact steps 
for printing a document may vary depending on the application 
program you are using. Refer to the User’s Guide of your 
software application for the exact printing procedure.

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is 
displayed. It may look slightly different depending on your 
application. 

The basic print settings are selected within the Print 
window. These settings include the number of copies and 
print range.

3 Select your printer driver from the Name drop-down 
list.

To take advantage of the printer features provided by your 
printer driver, click Properties or Preferences in the 
application’s Print window. For details, see “Printer 
Settings” on page 14.

If you see Setup, Printer, or Options in your Print 
window, click it instead. Then click Properties on the next 
screen.

Click OK to close the printer properties window.
4 To start the print job, click OK or Print in the Print 

window.

Make sure that your 
printer is selected.
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Printing to a file (PRN)  
You will sometimes need to save the print data as a file for your 
purpose. 

To create a file:
1 Check the Print to file box at the Print window.

2 Select the folder and assign a name of the file and then 
click OK.

NOTES: To print the prn file, you must have the utility which 
sends prn file to USB port in DOS prompt. 

Printer Settings
You can use the printer properties window, which allows you to 
access all of the printer options you need when using your 
printer. When the printer properties are displayed, you can 
review and change the settings needed for your print job. 

Your printer properties window may differ, depending on your 
operating system. This Software User’s Guide shows the 
Properties window for Windows XP.

Your printer driver Properties window that appears in this 
User’s Guide may differ depending on the printer in use.

If you access printer properties through the Printers folder, you 
can view additional Windows-based tabs (refer to your 
Windows User’s Guide) and the Printer tab (see “Printer Tab” on 
page 18).

NOTES:
• Most Windows applications will override settings you specify 

in the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are 
using the current program. To make your changes 
permanent, make them in the Printers folder. 

• The following procedure is for Windows XP. For other 
Windows OS, refer to the corresponding Windows User's 
Guide or online help.
1. Click the Windows Start button.
2. Select Printers and Faxes.
3. Select your printer driver icon.
4. Right-click on the printer driver icon and select 

Printing Preferences.
5. Change the settings on each tab, click OK.
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Layout Tab
The Layout tab provides options to adjust how the document 
appears on the printed page. The Layout Options includes 
Multiple Pages per Side,  Poster Printing and Booklet 
Printing. See “Printing a Document” on page 13 for more 
information on accessing printer properties.  

Paper Orientation
Paper Orientation allows you to select the direction in which 
information is printed on a page. 
• Portrait prints across the width of the page, letter style. 
• Landscape prints across the length of the page, spreadsheet 

style. 
• Rotate allows you to rotate the page the selected degrees.

Layout Options
Layout Options allows you to select advanced printing options. 
You can choose Multiple Pages per Side and Poster Printing.
• For details, see “Printing Multiple Pages on One Sheet of Paper 

(N-Up Printing)” on page 19.
• For details, see “Printing Posters” on page 20
• For details, see “Printing Booklets” on page 20

Double-sided Printing
Double-sided Printing allows you to print on both sides of 
paper. If this option does not appear, your printer does 
not have this feature.
• For details, see “Printing on Both Sides of Paper” on page 21.

 Landscape Portrait

Paper Tab
Use the following options to set the basic paper handling 
specifications when you access the printer properties. See 
“Printing a Document” on page 13 for more information on 
accessing printer properties. 

Click the Paper tab to access various paper properties. 

Copies
Copies allows you to choose the number of copies to be printed. 
You can select 1 to 999 copies. 

Collate
This option automatically sorts the copies when you make more 
than two copies. For instance, if you make 2 copies of a 5-page 
document, the printer prints the document in order of pages 1 to 
5 of the first copy, and pages 1 to 5 of the second copy. If you do 
not select this option, the printer prints the document in order of 
1 to 1, 2 to 2, ...., 5 to 5 so you must sort the document after 
printing. If this option does not appear, your printer does 
not have this feature.

Paper Options

Size
Size allows you to set the size of paper you loaded in the tray. 
If the required size is not listed in the Size box, click Custom. 
When the Custom Paper Setting window appears, set the paper 
size and click OK. The setting appears in the list so that you can 
select it. 

Source
Make sure that Source is set to the corresponding paper tray.
Use Manual Feeder when printing on special materials like 
envelopes and transparencies. You have to load one sheet at a 
time into the Manual Tray or Multi-Purpose Tray.
If the paper source is set to Auto Selection, the printer 
automatically picks up print material in the following tray order: 
Manual Tray or Multi-Purpose Tray, Tray n.
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Type
Set Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality 
printout. If not, print quality may not be acheived as you want.
Cotton: 20 lb to 24 lb (75~90 g/m2) cotton paper such as Gilbert 
25 % and Gilbert 100 %. 
Plain Paper: Normal plain paper. Select this type if your printer is 
monochrome and printing on the 16 lb (60 g/m2) cotton paper. 
Recycled Paper: 20 lb to 24 lb (75~90 g/m2) recycled paper.
Color: 20 lb to 24 lb (75~90 g/m2) color-backgrounded paper.  
Thick: 24 lb to 28 lb (90~105 g/m2) thick paper.
Thin: 16 lb to 19 lb (60~70 g/m2) thin paper.
Bond: When you use the bond paper, select this option.
Archive: When you need to keep print-out for a long period time 
such as archives, select this option.

First Page 
This property allows you to print the first page using a different 
paper type from the rest of the document. You can select the 
paper source for the first page. 
For example, load thick stock for the first page into the Multi-
purpose Tray, and plain paper into Tray n. Then, select Tray n in 
the Source option and Multi-Purpose Tray in the First Page 
option. If this option does not appear, your printer does 
not have this feature.

Scaling Printing
Scaling Printing allows you to automatically or manually scale 
your print job on a page. You can choose from None, Reduce/
Enlarge, and Fit to Page. 
• For details, see “Printing a Reduced or Enlarged Document” on 

page 21.
• For details, see “Fitting Your Document to a Selected Paper 

Size” on page 21.

Graphics Tab
Use the following Graphic options to adjust the print quality for 
your specific printing needs. See “Printing a Document” on 
page 13 for more information on accessing printer properties. 

Click the Graphic tab to display the properties shown below. 

Quality
The Quality options you can select may vary depending 
on your printer model. The higher the setting, the sharper the 
clarity of printed characters and graphics. The higher setting also 
may increase the time it takes to print a document. 

Color Mode
You can choose color options. Setting to Color typically produces 
the best possible print quality for color documents. If you want to 
print a color document in grayscale, select Grayscale. If you 
want to adjust the color options manually, select Manual and 
click the Color Adjust or Color Matching button.
• Color Adjust : You can adjust the appearance of images by 

changing the settings in the Levels option.
• Color Matching : You can adjust the appearance of images by 

changing the settings in the Settings option.
• Copies Setting: When you make several copies, and if you 

want to make some of copies are printed in color and others are 
in grayscale, use this option and select the number of copies in 
grayscale.
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Advanced Options
You can set advanced settings by clicking the Advanced 
Options button. 
• Raster Compression: This option determines the 

compression level of images for transferring data from a 
computer to a printer. If you set this option to Maximum, the 
printing speed will be high, but the printing quality will be low.

• TrueType Options: This option determines what the driver 
tells the printer about how to image the text in your document. 
Select the appropriate setting according to the status of your 
document.
- Download as Outline: When this option is selected, the 
driver will download any TrueType fonts that are used in your 
document not already stored (resident) on your printer. If, 
after printing a document, you find that the fonts did not print 
correctly, choose Download as bit image and resubmit your 
print job. The Download as bit image setting is often useful 
when printing Adobe. This feature is available only 
when you use the PCL printer driver.

- Download as Bitmap: When this option is selected, the    
driver will download the font data as bitmap images.    
Documents with complicated fonts, such as Korean or    
Chinese, or various other fonts, will print faster in this setting. 

- Print as Graphics: When this option is selected, the driver 
will download any fonts as graphics. When printing documents 
with high graphic content and relatively few TrueType fonts, 
printing performance (speed) may be enhanced in this 
setting.

• Print All Text To Black: When the Print All Text To 
Black option is checked, all text in your document prints solid 
black, regardless of the color it appears on the screen. 

• Print All Text To Darken: When the Print All Text To 
Darken option is checked, all text in your document is allowed 
to print darker than on a normal document. Some printers do 
not support this feature. 

• Grayscale Enhancement: Press the Smart Color tab. It 
allows users to preserve the details of nature photos, and 
improve contrast and readability among gray scaled colors, 
when printing color documents in grayscale. 

• Fine Edge: Press the Smart Color tab. It allows users to 
emphasize edges of texts and fine lines for improving 
readability and align each color channel registration in color 
printing mode. 

Extras Tab
You can select output options for your document. See “Printing 
a Document” on page 13 for more information about accessing 
the printer properties.

Click the Extras tab to access the following feature:  

Watermark
You can create a background text image to be printed on each 
page of your document. For details, see “Using Watermarks” on 
page 22.

Overlay
Overlays are often used to take the place of preprinted forms and 
letterhead paper. For details, see “Using Overlays” on page 23.

Output Options
• Print Subset: You can set the sequence in which the pages 

print. Select the print order from the drop-down list.
- Normal (1,2,3): Your printer prints all pages from the first 
page to the last page.

- Reverse All Pages (3,2,1): Your printer prints all pages 
from the last page to the first page.

- Print Odd Pages: Your printer prints only the odd numbered 
pages of the document.

- Print Even Pages: Your printer prints only the even 
numbered pages of the document.

• Use Printer Fonts: When Use Printer Fonts is checked, the 
printer uses the fonts that are stored in its memory (resident 
fonts) to print your document, rather than downloading the 
fonts used in your document. Because downloading fonts takes 
time, selecting this option can speed up your printing time. 
When using Printer fonts, the printer will try to match the fonts 
used in your document to those stored in its memory. If, 
however, you use fonts in your document that are very different 
from those resident in the printer, your printed output will 
appear very different from what it looks like on the screen.  
This feature is available only when you use the PCL 
printer driver.
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About Tab
Use the About tab to display the copyright notice and the 
version number of the driver. If you have an Internet browser, 
you can connect to the Internet by clicking on the web site icon. 
See “Printing a Document” on page 13 for more information 
about accessing printer properties.

Printer Tab
If you access printer properties through the Printers folder, 
you can view the Printer tab. You can set the printer 
configuration.

The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.
1 Click the Windows Start menu. 

2 Select Printers and Faxes.

3 Select your printer driver icon. 

4 Right-click on the printer driver icon and select 
Properties.

5 Click the Printer tab and set the options.  

Using a Favorite Setting  
The Favorites option, which is visible on each properties tab, 
allows you to save the current properties settings for future 
use. 

To save a Favorites item:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 

When you save Favorites, all current driver settings are 
saved.

To use a saved setting, select the item from the Favorites drop 
down list. The printer is now set to print according to the 
Favorites setting you selected. 

To delete a Favorites item, select it from the list and click 
Delete. 

You can also restore the printer driver’s default settings by 
selecting Printer Default from the list. 

Using Help
Your printer has a help screen that can be activated by clicking 
the Help button in the printer properties window. These help 
screens give detailed information about the printer features 
provided by the printer driver.

You can also click  from the upper right corner of the window, 
and then click on any setting. 
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3 Advanced Printing
This chapter explains printing options and advanced printing 
tasks. 

NOTE: 
• Your printer driver Properties window that appears in this 

User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

This chapter includes:

• Printing Multiple Pages on One Sheet of Paper (N-Up 
Printing)

• Printing Posters

• Printing Booklets

• Printing on Both Sides of Paper

• Printing a Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Using Watermarks

• Using Overlays

Printing Multiple Pages on One 
Sheet of Paper (N-Up Printing) 
You can select the number of pages to print on a single sheet 
of paper. To print more than one page per sheet, the pages will 
be reduced in size and arranged in the order you specify. You 
can print up to 16 pages on one sheet.  

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 13.

2 From the Layout tab, choose Multiple Pages per Side in 
the Layout Type drop-down list. 

3 Select the number of pages you want to print per sheet 
(1, 2, 4, 6, 9, or 16) in the Pages per Side drop-down 
list.

4 Select the page order from the Page Order drop-down 
list, if necessary. 

Check Print Page Border to print a border around each 
page on the sheet. 

5 Click the Paper tab, select the paper source, size, and 
type.

6 Click OK and print the document. 
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Printing Posters
This feature allows you to print a single-page document onto 4, 
9, or 16 sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 13.

2 Click the Layout tab, select Poster Printing in the 
Layout Type drop-down list.

3 Configure the poster option:

You can select the page layout from Poster<2x2>, 
Poster<3x3>, Poster<4x4> or Custom. If you select 
Poster<2x2>, the output will be automatically stretched 
to cover 4 physical pages. If the option is set to Custom, 
you can enlarge the original from 150% to 400%. 
Depending on the level of the enlargement, the page 
layout is automatically adjusted to Poster<2x2>, 
Poster<3x3>, Poster<4x4>. 

Specify an overlap in millimeters or inches to make it 
easier to pasting the sheets together. 

4 Click the Paper tab, select the paper source, size, and 
type.

5 Click OK and print the document. You can complete the 
poster by pasting the sheets together. 

0.15 inches

0.15 inches

Printing Booklets 

This printer feature allows you to print your document on both 
sides of the paper and arranges the pages so that the paper can 
be folded in half after printing to produce a booklet. 
1 To change the print settings from your software 

application, access the printer properties. See “Printing a 
Document” on page 13.

2 From the Layout tab, choose Booklet Printing from the 
Layout Type drop-down list. 

NOTE: The Booklet Printing option is not available for all 
paper sizes. In order to find out the available paper size for 
this feature, select the paper size in the Size option on the 
Paper tab, then check if the Booklet Printing in a Layout 
Type drop-down list on the Layout tab is activated.

3 Click the Paper tab, and select the paper source, size, and 
type.

4 Click OK and print the document.

5 After printing, fold and staple the pages. 
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Printing on Both Sides of Paper
You can print on both sides of a sheet of paper. Before printing, 
decide how you want your document oriented.

The options are:

• Printer Setting, if you select this option, this feature is 
determined by the setting you’ve made on the control 
panel of the printer. If this option does not appear, 
your printer does not have this feature.

• None

• Long Edge, which is the conventional layout used in 
book binding.

• Short Edge, which is the type often used with calendars.

• Reverse Duplex Printing, allows you to select general 
print order compare to duplex print order. If this option 
does not appear, your printer does not have this 
feature.

NOTE: Do not print on both sides of labels, transparencies, 
envelopes, or thick paper. Paper jamming and damage to the 
printer may result. 

1 To change the print settings from your software 
application, access printer properties. “Printing a 
Document” on page 13.

2 From the Layout tab, select the paper orientation.

3 From the Double-sided Printing section, select the 
binding option you want.     

4 Click the Paper tab and select the paper source, size, and 
type.

5 Click OK and print the document.

NOTE: If your printer does not have a duplex unit, you should 
complete the printing job manually. The printer prints every 
other page of the document first. After printing the first side of 
your job, the Printing Tip window appears. Follow the on-
screen instructions to complete the printing job.

 Long Edge▲  Short Edge▲

Printing a Reduced or Enlarged 
Document 
You can change the size of a page’s content to appear larger or 
smaller on the printed page. 

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 13. 

2 From the Paper tab, select Reduce/Enlarge in the 
Printing Type drop-down list. 

3 Enter the scaling rate in the Percentage input box.

You can also click the  or  button.
4 Select the paper source, size, and type in Paper Options. 

5 Click OK and print the document. 

Fitting Your Document to a 
Selected Paper Size
This printer feature allows you to scale your print job to any 
selected paper size regardless of the digital document size. This 
can be useful when you want to check fine details on a small 
document. 

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 13.

2 From the Paper tab, select Fit to Page in the Printing 
Type drop-down list. 

3 Select the correct size from the Output size drop-down 
list.

4 Select the paper source, size, and type in Paper Options.

5 Click OK and print the document.
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Using Watermarks
The Watermark option allows you to print text over an existing 
document. For example, you may want to have large gray 
letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally 
across the first page or all pages of a document. 

There are several predefined watermarks that come with the 
printer, and they can be modified, or you can add new ones to 
the list. 

Using an Existing Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 13. 

2 Click the Extras tab, and select the desired watermark 
from the Watermark drop-down list. You will see the 
selected watermark in the preview image. 

3 Click OK and start printing. 

NOTE: The preview image shows how the page will look when 
it is printed.

Creating a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 13. 

2 Click the Extras tab, and click the Edit button in the 
Watermark section. The Edit Watermark window 
appears. 

3 Enter a text message in the Watermark Message box. 
You can enter up to 40 characters. The message displays 
in the preview window.

When the First Page Only box is checked, the watermark 
prints on the first page only.

4 Select watermark options. 

You can select the font name, style, size, or grayscale level 
from the Font Attributes section and set the angle of the 
watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list.   

6 When you have finished editing, click OK and start 
printing. 

To stop printing the watermark, select (No Watermark) from 
the Watermark drop-down list. 

Editing a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 13. 

2 Click the Extras tab and click the Edit button in the 
Watermark section. The Edit Watermark window 
appears.

3 Select the watermark you want to edit from the Current 
Watermarks list and change the watermark message and 
options. 

4 Click Update to save the changes.

5 Click OK until you exit the Print window. 

Deleting a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 13.

2 From the Extras tab, click the Edit button in the 
Watermark section. The Edit Watermark window 
appears. 

3 Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4 Click OK until you exit the Print window.
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Using Overlays

What is an Overlay?
An overlay is text and/or images stored in the computer hard 
disk drive (HDD) as a special file format that can be printed on 
any document. Overlays are often used to take the place of 
preprinted forms and letterhead paper. Rather than using 
preprinted letterhead, you can create an overlay containing the 
exact same information that is currently on your letterhead. To 
print a letter with your company’s letterhead, you do not need 
to load preprinted letterhead paper in the printer. You need only 
tell the printer to print the letterhead overlay on your 
document.

Creating a New Page Overlay
To use a page overlay, you must create a new page overlay 
containing your logo or image.

1 Create or open a document containing text or an image for 
use in a new page overlay. Position the items exactly as 
you wish them to appear when printed as an overlay.

2 To save the document as an overlay, access printer 
properties. See “Printing a Document” on page 13.

3 Click the Extras tab, and click Edit button in the Overlay 
section. 

4 In the Edit Overlay window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to eight 
characters in the File name box. Select the destination 
path, if necessary. (The default is C:\Formover).

6 Click Save. The name appears on the Overlay List box. 

7 Click OK or Yes to finish creating. 

The file is not printed. Instead it is stored on your 
computer hard disk drive. 

NOTE: The overlay document size must be the same as the 
documents you print with the overlay. Do not create an overlay 
with a watermark. 

Using a Page Overlay
After an overlay has been created, it is ready to be printed with 
your document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 13. 

3 Click the Extras tab. 

4 Select the desired overlay from the Overlay drop-down 
list box. 

5 If the overlay file you want does not appear in the 
Overlay list, click Edit button and Load Overlay, and 
select the overlay file. 

If you have stored the overlay file you want to use in an 
external source, you can also load the file when you access 
the Load Overlay window. 

After you select the file, click Open. The file appears in the 
Overlay List box and is available for printing. Select the 
overlay from the Overlay List box. 

6 If necessary, click Confirm Page Overlay When 
Printing. If this box is checked, a message window 
appears each time you submit a document for printing, 
asking you to confirm your wish to print an overlay on your 
document. 

If this box is not checked and an overlay has been 
selected, the overlay automatically prints with your 
document. 

7 Click OK or Yes until printing begins. 

The selected overlay downloads with your print job and 
prints on your document. 

NOTE: The resolution of the overlay document must be the 
same as that of the document you will print with the overlay. 

Deleting a Page Overlay
You can delete page overlays that you no longer use. 

1 In the printer properties window, click the Extras tab. 

2 Click the Edit button in the Overlay section. 

3 Select the overlay you want to delete from the Overlay 
List box. 

4 Click Delete Overlay. 

5 When a confirming message window appears, click Yes.

6 Click OK until you exit the Print window.
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4 Using Windows 
PostScript Driver
If you want to use the PostScript driver provided with your 
system CD-ROM to print a document.

PPDs, in combination with the PostScript driver, access printer 
features and allow the computer to communicate with the 
printer. An installation program for the PPDs is provided on the 
supplied software CD-ROM. 

Printer Settings
You can use the printer properties window, which allows you to 
access all of the printer options you need when using your 
printer. When the printer properties are displayed, you can 
review and change the settings needed for your print job. 

Your printer properties window may differ, depending on your 
operating system. This Software User’s Guide shows the 
Properties window for Windows XP.

Your printer driver Properties window that appears in this 
User’s Guide may differ depending on the printer in use.

NOTES:
• Most Windows applications will override settings you specify 

in the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are 
using the current program. To make your changes 
permanent, make them in the Printers folder. 

• The following procedure is for Windows XP. For other 
Windows OS, refer to the corresponding Windows User's 
Guide or online help.
1. Click the Windows Start button.
2. Select Printers and Faxes.
3. Select your printer driver icon.
4. Right-click on the printer driver icon and select 

Printing Preferences.
5. Change the settings on each tab, click OK.

Advanced
You can use advanced settings by clicking the Advanced 
button. 

• Paper/Output this option allows you to select the size of the 
paper loaded in the tray.

• Graphic this option allows you to adjust the print quality for 
your specific printing needs.

• Document Options this options allow you to set the PostScript 
options or printer features.

Using Help
You can click  from the upper right corner of the window, and 
then click on any setting. 
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5 Sharing the Printer 
Locally
You can connect the printer directly to a selected computer, 
which is called “host computer,” on the network. 

The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.

NOTES: 
• Check the Operating System(s) that are compatible with 

your printer. Please refer to the OS Compatibility section of 
Printer Specifications in your Printer User’s Guide.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

Setting Up a Host Computer

1 Start Windows. 

2 From the Start menu select Printers and Faxes. 

3 Double-click your printer driver icon. 

4 From the Printer menu, select Sharing. 

5 Check the Share this printer box.

6 Fill in the Shared Name field, and then click OK.

Setting Up a Client Computer 

1 Right-click the Windows Start button and select Explorer.

2 Select My Network Places  and then right-click Search 
for Computers.

3 Fill in the IP address of host computer in Computer name 
field, and click Search. (In case host computer requires 
User name and Password, fill in User ID and password 
of host computer account.)

4 Double-click Printers and Faxes.

5 Right-click printer driver icon, select Connect.

6 Click Yes, if the installation confirm message appears.
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6 Using Smart Panel
Smart Panel is a program that monitors and informs you of the 
status of the printer, and allows you to customize the printer’s 
settings. Smart Panel is installed automatically when you 
install the printer software.

NOTES:
• To use this program, you need:

- To check for Operating System(s) that are compatible with 
your printer, refer to Printer Specifications in your Printer 
User’s Guide.

- Mac OS X 10.3 or higher
- Linux. To check for Linux systems that are compatible with 

your printer, refer to Printer Specifications in your Printer 
User’s Guide.

- Internet Explorer version 5.0 or higher for flash animation 
in HTML Help.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

Understanding Smart Panel
If an error occurs while printing, Smart Panel appears 
automatically, showing the error.

You can also launch Smart Panel manually. Double-click the 
Smart Panel icon on the Windows task bar (in Windows), or 
Notification Area (in Linux). You can also click it on the status 
bar (in Mac OS X).

Double-click this icon in Windows.

Click this icon in Mac OS X.

Click this icon in Linux.

If you are a Windows user, from the Start menu, select 
Programs or All Programs  → your printer driver name → 
Smart Panel.

NOTES: 
• If you have already installed more than one Samsung 

printer, first select the printer model you want in order to 
use the corresponding Smart Panel. Right-click (in Windows 
or Linux) or click (in Mac OS X) the Smart Panel icon and 
select your printer name.

• The Smart Panel window and its contents shown in this 
Software User’s Guide may differ depending on the printer or 
Operating System in use.

The Smart Panel program displays the current status of the 
printer, the level of toner remaining in the toner cartridge(s) 
and various other information. You can also change settings.

Toner Level
You can view the level of toner remaining in the toner 
cartridge(s). The printer and the number of toner cartridge(s) 
shown in the above window may differ depending on the printer in 
use. Any printers do not have this feature.

Buy Now
You can order replacement toner cartridge(s) online.

Troubleshooting Guide
You can view Help to solve problems.

Printer Setting
You can configure various printer settings in the Printer Settings 
Utility window. Any printers do not have this feature.

NOTE: If your printer is connected to a network and you are a 
Windows user, the SyncThru Web Service window appears 
instead of the Printer Settings Utility window. Linux does not 
support network environments.

Driver Setting (Only for Windows)
You can use the printer properties window, which allows you to 
access all of the printer options you need for using your 
printer. For details, See “Printer Settings” on page 14.

1

1
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Opening the Troubleshooting 
Guide
Using the troubleshooting guide, you can view solutions for 
error status problems.

Right-click (in Windows or Linux) or click (in Mac OS X) the 
Smart Panel icon and select Troubleshooting Guide.

Using Printer Settings Utility
Using the Printer Settings Utility, you can configure and check 
print settings. 

1 Right-click (in Windows or Linux) or click (in Mac OS X) the 
Smart Panel icon and select Printer Setting.

2 Change the settings. 

3 To send the changes to the printer, click the Apply button.

NOTES: If your printer is connected to a network, the 
SyncThru Web Service window appears instead of the 
Printer Settings Utility window.

Using Onscreen Help File
For more information about Printer Settings Utility, click  . 

Changing the Smart Panel 
Program Settings
Right-click (in Windows or Linux) or click (in Mac OS X) the 
Smart Panel icon and select Options.

The following window opens.

• Display when job is finished for network printer: The 
computer shows the Smart Panel popup window or 
balloon when your job is complete in Windows. (Only for 
Windows network-supported or Macintosh x 
supported printers.)

• Display when error occurs during printing: The 
computer shows the Smart Panel popup window or 
balloon when an error occurs during printing.

• Display with: You can select how the computer shows 
you a message. If you select Popup window (Smart 
Panel), the message appears in the Smart Panel popup 
window in Windows.

• Launch Job Monitor when the job is saved in the 
printer: If you store print jobs on the printer’s hard disk, 
the computer opens the Job Monitor window in Windows. 
(Only for Windows network-supported printers with 
built-in hard disks.)

• Schedule an automatic status checking every: The 
computer updates the printer status regularly. Setting the 
value close to 1 second causes the computer to check the 
printer status more frequently, thereby allowing a faster 
response to any printer error.
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7 Using Your Printer in 
Linux 
You can use your machine in a Linux environment. 

This chapter includes:

• Getting Started

• Installing the Unified Linux Driver

• Using the Unified Driver Configurator

• Configuring Printer Properties

• Printing a Document

Getting Started
The supplied CD-ROM provides you with Samsung’s Unified 
Linux Driver package for using your machine with a Linux 
computer.

After the driver is installed on your Linux system, the driver 
package allows you to monitor a number of machine devices via 
fast ECP parallel ports and USB simultaneously. 

The Unified Linux Driver package is supplied with a smart and 
flexible installation program. You don't need to search for 
additional components that might be necessary for the Unified 
Linux Driver software: all required packages will be carried onto 
your system and installed automatically; this is possible on a 
wide set of the most popular Linux clones.

Installing the Unified Linux 
Driver

Installing the Unified Linux Driver
1 Make sure that you connect your machine to your 

computer. Turn both the computer and the machine on.
2 When the Administrator Login window appears, type in 

root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to install the 
printer software. If you are not a super user, ask your system 
administrator.

3 Insert the printer software CD-ROM. The CD-ROM will 
automatically run.

If the CD-ROM does not automatically run, click the  
icon at the bottom of the desktop. When the Terminal 
screen appears, type in:

If the CD-ROM is secondary master and the location to 
mount is /mnt/cdrom,

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/
cdrom

[root@localhost root]#cd /mnt/cdrom/Linux

[root@localhost root]#./install.sh 

If you still failed to run the CD-ROM, type the followings 
in sequence:

[root@localhost root]#unmount/dev/hdc 

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/
cdrom

NOTE: The installation program runs automatically if you 
have an autorun software package installed and configured.
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4 When the welcome screen appears, click Next.

5 When the installation is complete, click Finish.

The installation program has added the Unified Driver 
Configurator desktop icon and Samsung Unified Driver 
group to the system menu for your convenience. If you 
have any difficulties, consult the onscreen help that is 
available through your system menu or can otherwise be 
called from the driver package windows applications, 
such as Unified Driver Configurator.

NOTES: Installing the driver in the text mode:

• If you do not use the graphical interface or have failed the 
driver installation, you have to use the driver in the text 
mode.

• Follow the step 1 to 3, then type [root@localhost Linux]# ./
install.sh, than follow the instruction on the terminal screen. 
Then the installation completes.

• When you wan to uninstall the driver, follow the installation 
instruction above, but type [root@localhost Linux]# ./
uninstall.sh on the terminal screen.

Uninstalling the Unified Linux Driver
1 When the Administrator Login window appears, type in 

root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to install the 
printer software. If you are not a super user, ask your system 
administrator.

2 Insert the printer software CD-ROM. The CD-ROM will 
automatically run.

If the CD-ROM does not automatically run, click the  
icon at the bottom of the desktop. When the Terminal 
screen appears, type in:

If the CD-ROM is secondary master and the location to 
mount is /mnt/cdrom,

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/
cdrom

[root@localhost root]#cd /mnt/cdrom/Linux

[root@localhost root]#./uninstall.sh 

NOTE: The installation program runs automatically if you 
have an autorun software package installed and configured.

3 Click Uninstall.

4 Click Next. 

5 Click Finish.
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Using the Unified Driver 
Configurator
Unified Linux Driver Configurator is a tool primarily intended for 
configuring Printer.

After installing the Unified Linux driver, the Unified Linux Driver 
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver 
Configurator
1 Double-click Unified Driver Configurator on the 

desktop.

You can also click the Startup Menu icon and select 
Samsung Unified Driver and then Unified Driver 
Configurator.

2 Press each button on the Modules pane to switch to the 
corresponding configuration window. 

You can use the onscreen help by clicking Help.
3 After changing the configurations, click Exit to close the 

Unified Driver Configurator.

Printers Configuration button

Ports Configuration button

Printers Configuration
Printers configuration has the two tabs: Printers and Classes. 

Printers Tab
You can see the current system’s printer configuration by 
clicking on the printer icon button on the left side of the Unified 
Driver Configurator window.

You can use the following printer control buttons:

• Refresh: renews the available printers list.

• Add Printer: allows you to add a new printer.

• Remove Printer: removes the selected printer.

• Set as Default: sets the current printer as a default 
printer.

• Stop/Start: stops/starts the printer.

• Test: allows you to print a test page to check if the 
machine is working properly.

• Properties: allows you to view and change the printer 
properties. For details, see page 31.

Shows all of the 
installed printer.

Switches to Printer 
configuration.

Shows the status, 
model name and 
URI of your printer.
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Classes Tab
The Classes tab shows a list of available printer classes.

• Refresh : Renews the classes list.

• Add Class... : Allows you to add a new printer class.

• Remove Class : Removes the selected printer class.

Ports Configuration
In this window, you can view the list of available ports, check 
the status of each port and release a port that is stalled in busy 
state when its owner is terminated for any reason.

• Refresh : Renews the available ports list.

• Release port : Releases the selected port.

Shows the status of the 
class and the number of 
printers in the class.

Shows all of the 
printer classes.

Switches to 
ports 
configuration.

Shows the port type, 
device connected to 
the port and status

Shows all of the 
available ports.

Configuring Printer Properties
Using the properties window provided by the Printers 
configuration, you can change the various properties for your 
machine as a printer.
1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2 Select your machine on the available printers list and click 

Properties.
3 The Printer Properties window opens.

The following five tabs display at the top of the window:
•General: allows you to change the printer location and 
name. The name entered in this tab displays on the 
printer list in Printers configuration.

•Connection: allows you to view or select another port. If 
you change the printer port from USB to parallel or vice 
versa while in use, you must re-configure the printer port 
in this tab.

•Driver: allows you to view or select another printer 
driver. By clicking Options, you can set the default 
device options.

•Jobs: shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed 
jobs check box to see previous jobs on the job list.

•Classes: shows the class that your printer is in. Click 
Add to Class to add your printer to a specific class or 
click Remove from Class to remove the printer from the 
selected class.

4 Click OK to apply the changes and close the Printer 
Properties Window.
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Printing a Document

Printing from Applications
There are a lot of Linux applications that you are allowed to 
print from using Common UNIX Printing System (CUPS). You 
can print on your machine from any such application.
1 From the application you are using, select Print from the 

File menu.
2 Select Print directly using lpr.

3 In the LPR GUI window, select the model name of your 
machine from the Printer list and click Properties.

4 Change the printer and print job properties.

Click.

The following four tabs display at the top of the window.
•General - allows you to change the paper size, the paper 
type, and the orientation of the documents, enables the 
duplex feature, adds start and end banners, and changes 
the number of pages per sheet.

•Text - allows you to specify the page margins and set the 
text options, such as spacing or columns.

•Graphics - allows you to set image options that are used 
when printing images/files, such as color options, image 
size, or image position.

•Device: allows you to set the print resolution, paper 
source, and destination.

5 Click Apply to apply the changes and close the Properties 
window. 

6 Click OK in the LPR GUI window to start printing.

7 The Printing window appears, allowing you to monitor the 
status of your print job.

To abort the current job, click Cancel.

Printing Files
You can print many different types of files on the Samsung 
machine device using the standard CUPS way - directly from 
the command line interface. The CUPS lpr utility allows you do 
that. But the drivers package replaces the standard lpr tool by 
a much more user-friendly LPR GUI program.

To print any document file:
1 Type lpr <file_name> from the Linux shell command 

line and press Enter. The LPR GUI window appears.

When you type only lpr and press Enter, the Select 
file(s) to print window appears first. Just select any files 
you want to print and click Open. 

2 In the LPR GUI window, select your printer from the list, 
and change the printer and print job properties.

For details about the properties window, see page 32.
3 Click OK to start printing.
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8 Using Your Printer with 
a Macintosh
Your machine supports Macintosh systems with a built-in USB 
interface or a 10/100 Base-TX network interface card. When 
you print a file from a Macintosh computer, you can use the 
PostScript driver by installing the PPD file.

NOTE: Some printers do not support a network 
interface. Make sure that your printer supports a 
network interface by referring to Printer Specifications 
in your Printer User’s Guide.

This chapter includes:

• Installing Software

• Setting Up the Printer

• Printing

Installing Software
The CD-ROM that came with your printer provides you with the 
PPD file that allows you to use the CUPS driver or Apple 
LaserWriter driver (only available when you use a printer 
which supports the PostScript driver), for printing on a 
Macintosh computer. 

Printer driver

Installing the Printer driver
1 Connect your machine to the computer using the USB 

cable or the Ethernet cable. 
2 Turn on your computer and the machine.

3 Insert the PostScript driver CD-ROM which came with your 
machine into the CD-ROM drive.

4 Double-click the Samsung_CLBP on your Macintosh 
desktop. 

5 Double-click the MAC_Installer folder.

6 Double-click the MAC_Printer folder.

7 Double-click the Samsung CLBP Installer OSX icon.

8 Click Continue.

9 Click Install.

10After the installation is finished, click Quit.

Uninstalling the Printer driver
1 Insert the CD-ROM which came with your printer into the 

CD-ROM drive.
2 Double-click CD-ROM icon that appears on your 

Macintosh desktop.
3 Double-click the Samsung_CLBP on your Macintosh 

desktop. 
4 Double-click the MAC_Installer folder.

5 Double-click the MAC_Printer folder.

6 Double-click the Samsung CLBP Installer OSX icon.

7 Select Uninstall and then click Uninstall.

8 Click Continue.

9 When the uninstallation is done, click Quit.
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Setting Up the Printer 
Set up for your printer will be different depending on which 
cable you use to connect the printer to your computer—the 
network cable or the USB cable.

For a Network-connected

NOTE: Some printers do not support a network 
interface. Before connecting your printer, make sure 
that your printer supports a network interface by 
referring to Printer Specifications in your Printer User’s 
Guide.

1 Follow the instructions on “Installing Software” on page 33 
to install the PPD files on your computer.

2 Open the Applications folder > Utilities, and Printer 
Setup Utility.

•For Macintosh OS 10.5, open System Preferences for 
the Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.

•For Macintosh OS 10.5, press the + icon then a display 
window will pop up.

4 Select the Bonjour (Default Browser, Default) tab. 

Then name of your machine appears on the list. Select 
Samsung CLP-6xx Series (SEC000xxxxxxxxx) from 
the printer box, where the xxxxxxxxx varies depending 
on your machine. 

5 If Auto Select does not work properly, select Samsung in 
Printer Model and your printer name in Model Name. 

Your machine appears on the Printer List and is set as the 
default printer.

6 Click Add.

For a USB-connected
1 Follow the instructions on “Installing Software” on page 33 

to install the PPD files on your computer.
2 Open the Applications folder > Utilities, and Printer 

Setup Utility.

•For Macintosh OS 10.5, open System Preferences for 
the Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.

•For Macintosh OS 10.5, press the + icon then a display 
window will pop up.

4 Select the USB tab.

•For Macintosh OS 10.4, click Default Browser and find 
the USB connection.

•For Macintosh OS 10.5, click Default and find the USB 
connection.

5 Select your printer name.

6 If Auto Select does not work properly, select Samsung in 
Printer Model and your printer name in Model Name.

Your machine appears on the Printer List and is set as the 
default printer.

7 Click Add.
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Printing 

NOTES: 
• The Macintosh printer’s properties window that appears in 

this User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• You can check your printer name in the supplied CD-
ROM.

Printing a Document
When you print with a Macintosh, you need to check the printer 
software setting in each application you use. Follow these steps 
to print from a Macintosh.

1 Open a Macintosh application and select the file you want 
to print.

2 Open the File menu and click Page Setup (Document 
Setup in some applications). 

3 Choose your paper size, orientation, scaling, and other 
options and click OK.

4 Open the File menu and click Print.

5 Choose the number of copies you want and indicate which 
pages you want to print. 

6 Click Print when you finish setting the options.

▲ Mac OS 10.3

Make sure that your 
printer is selected.

Changing Printer Settings
You can use advanced printing features when using your 
printer.

From your Macintosh application, select Print from the File 
menu. The printer name which appears in the printer properties 
window may differ depending on the printer in use. Except for 
the name, the composition of the printer properties window is 
similar.

NOTES: 
• Note: The setting options may differ depending on printers 

and Macintosh OS version.

Layout
The Layout tab provides options to adjust how the document 
appears on the printed page. You can print multiple pages on 
one sheet of paper. Select Layout from the Presets drop-down 
list to access the following features.

•Pages per Sheet: This feature determines how many 
pages printed on one page. For details, see "Printing 
Multiple Pages on One Sheet of Paper" on the next 
column.

•Layout Direction: You can select the printing direction 
on a page as like the examples on UI.

▲ Mac OS 10.4
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Graphics
The Graphics tab provides options for selecting 
Resolution(Quality) and Color Mode. Select Graphics form 
the Presets' drop-down list to access the graphic features.

•Resolution(Quality): You can select the printing 
resolution. The higher the setting, the sharper the clarity 
of printed characters and graphics. The higher setting 
also may increase the time it takes to print a document.

•Color Mode: You can set the color options. Setting to 
Color typically produces the best possible print quality 
for color documents. If you want to print a color 
document in grayscale, select Grayscale.

Paper
Set Paper Type to correspond to the paper loaded in the tray 
from which you want to print. This will let you get the best 
quality printout. If you load a different type of print material, 
select the corresponding paper type.

▲ Mac OS 10.4

▲ Mac OS 10.4

Printer Features
This tab provides options for selecting the paper type and 
adjusting print quality. Select Printer Features from the 
Presets' drop-down list to access the following features:

•Reverse Duplex Printing: Allows you to select general 
print order compare to duplex print order.

•Fit to Page: This setting allows you to scale your print 
job to any selected paper size regardless of the digital 
document size. This can be useful when you want to 
check fine details on a small document.

•RGB Color: This setting determines how colors are 
rendered. Standard is the most widely used setting 
which the color tone of this mode is the closest to that of 
standard monitor (sRGB Monitor). Vivid mode is 
appropriate for printing presentation data and charts. 
The color tone of Vivid mode produces more Vivid color 
images than that of Standard mode. Device mode is best 
used for printing fine lines, small characters and color 
drawings. The color tone of Device mode may be 
different from that of monitor, the pure toner colors are 
used for printing Cyan, Magenta and Yellow colors. 

•Fine Edge: It allows users to emphasize edges of texts 
and fine lines for improving readability and align each 
color channel registration in color printing mode. 

▲ Mac OS 10.4
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Printing Multiple Pages on One Sheet 
of Paper
You can print more than one page on a single sheet of paper. 
This feature provides a cost-effective way to print draft pages.

1 From your Macintosh application, select Print from the 
File menu. 

2 Select Layout.

3 Select the number of pages you want to print on one sheet 
of paper on the Pages per Sheet drop-down list.

4 Select the page order from the Layout Direction option.

To print a border around each page on the sheet, select 
the option you want from the Border drop-down list.

5 Click Print, and the printer prints the selected number of 
pages on one side of each page.

▲ Mac OS 10.3

Duplex Printing
You can print on both sides of the paper. Before printing in the 
duplex mode, decide on which edge you will be binding your 
finished document. The binding options are:

Long-Edge Binding: Which is the conventional layout 
used in book binding.

Short-Edge Binding: Which is the type often used with 
calendars. 

1 From your Macintosh application, select Print from the 
File menu. 

2 Select the Layout. 

3 Select a binding orientation from Two Sided Printing 
option.

4 Click Print and the printer prints on both sides of the 
paper. 

CAUTION: If you have selected duplex printing and 
then try to print multiple copies of a document, the 
printer may not print the document in the way you 
want. In case of  "Collated copy" , if your document has 
odd pages, the last page of the first copy and the first 
page of the next copy will be printed on the front and 
back of one sheet. In case of  "Uncollated copy", the 
same page will be printed on the front and back of one 
sheet. Therefore, if you need multiple copies of a 
document and you want those copies on both sides of 
the paper, you must print them one at a time, as 
separate print jobs.

▲ Mac OS 10.3
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SOFTWARE SECTION 
INDEX

A
advanced printing, use 19

B
booklet printing 20

D
document, print

Macintosh 35
Windows 13

double-sided printing 21

E
Extras properties, set 17

F
favorites settings, use 18

G
Graphics properties, set 16

H
help, use 18, 24

I
install

printer driver
Macintosh 33
Windows 4

installing
Linux software 28

L
Layout properties, set

Windows 15
Linux

driver, install 28
printer properties 31
printing 32

M
Macintosh

driver
install 33
uninstall 33

printing 35
setting up the printer 34

N
n-up printing

Macintosh 37
Windows 19

O
orientation, print 32

Windows 15
overlay

create 23
delete 23
print 23

P
Paper properties, set 15
paper size, set 15

print 32
paper source, set 32

Windows 15
paper type, set

print 32

poster, print 20
PostScript driver

installing 24
print

document 13
fit to page 21
from Macintosh 35
from Windows 13
N-up

Macintosh 37
Windows 19

overlay 23
poster 22
PRN 14
scaling 21
watermark 22

print resolution 32
printer driver, install

Linux 28
printer properties

Linux 32
printer properties, set

Macintosh 35
Windows 14, 24

printer resolution, set
Windows 16

printer software
install

Macintosh 33
Windows 4

uninstall
Macintosh 33
Windows 11

printing
booklets 20
double-sided 21
from Linux 32

R
resolution

printing 32
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S
setting

darkness 16
favorites 18
image mode 16
resolution

Windows 16
toner save 16
true-type option 16

software
install

Macintosh 33
Windows 4

reinstall
Windows 10

system requirements
Macintosh 33

uninstall
Macintosh 33
Windows 11

status monitor, use 26

T
toner save, set 16

U
uninstall, software

Macintosh 33
Windows 11

W
watermark

create 22
delete 22
edit 22
print 22
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